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In This User’s Guide...

The first six chapters of this user’s guide contains instructions for using the
Symtx N1891A-2 Payload Test System (PTS), including running tests, viewing
and printing data, and performing calibrations.

The second section, chapter seven, eight, and Appendix A, of this user’s guide
includes information and instructions for developing test plans, customizing data
presentations, and using the CITlfile data format.

The Symtx N1891A-2 Payload Test System (PTS) described in this user’s guide
is a modified version of the originally designed Agilent N1891A payload test
system. Unless noted, the original functionality of the Agilent Technologies
system still complies.

Chapter 1, “Getting Acquainted with the System”

Chapter 1 provides an introduction to the PTS. It includes an overview of the
PTS server and cabinet components, as well as the operating system and
system control.

Chapter 2, “Getting Started”

Chapter 2 describes the login procedures, using the online help system, using
the graphical interface, initializing and shutting down the system, and using the
switch matrix control window.

Chapter 3, “Running Tests, Viewing Data, and Printing Results”

Chapter 3 describes the test control windows, and provides information on
running tests, viewing and printing results, and using the Event Retriever.

Chapter 4, “Calibrating the System”

Chapter 4 describes the various system and instrument calibrations, as well as
how and when to use them.

Chapter 5, “Running the System Functional Test”

Chapter 5 describes the automated system functional test, including running the
individual tests, external connections, understanding test results,
troubleshooting, switch controls, and switch paths.

Chapter 6, “Creating Test Articles and Phases”

Chapter 6 describes how to use the graphical user interface (GUI) to set up and
define test articles and phases.
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Chapter 7, “Adding and Defining Tests and Calibrations”

Chapter 7 defines test-related support files; adding, editing, viewing, and printing
tests and support files; defining test IDs using support files; understanding
support file variables and syntax.

Chapter 8, “Customizing Data Presentation”

Chapter 8 describes how to use data presentation functions, such as modifying
report headers, defining graphs, defining tables, and printing data presentations.

Appendix A, “Using the CITIfile Data Format”

Appendix A describes the CITlfile syntax, how to use CITlfile packages, and
XML data formats.
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Symtx N1891A-2 Payload Test System (PTS) Documentation Set

The PTS is supported by the following system-level documents:

Symtx N1891A-2 User’s Guide 144115
Symtx N1891A-2 Acceptance Test Procedure 144107
Symtx N1891A-2 Measurement Reference 144105
LMN5002 MOUS RF ICD 144104
LMN5002 MOUS ICD 144103
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This chapter provides an introduction to the Symtx N1891A-2 Payload Test
System (PTS). It includes an overview of the PTS server computer and cabinet
components, as well as the operating system, and system control.

When you see the use of N1891AEXX, it refers to the generic form and you
should reference your unique configuration information; it is not to be taken
literally.
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Getting Acquainted with the System

Introducing the Symtx N1891A-2 Payload Test System (PTS)

14

Two major components make up the Symtx N1891A-2 PTS:
» Computer Equipment
* Measurement Cabinet

Computer Equipment

The PTS computer equipment is comprised of the following: server computer,
two measurement computers, printer, back-up tape drive, laptop computer, and
an additional display.

The server computer is the central computer in the Symtx N1891A-2 PTS. The
server computer communicates with the customer supplied test conductor
control computer through the customer's LAN. The server computer
orchestrates all of the tests and communications between the two measurement
computers through the test system's LAN.

The measurement computers are responsible for controlling a set of receive and
transmit equipment. The hardware is dedicated to a single computer, but the
ability exists to communicate to hardware across computers. Each
measurement computer has its own dedicated version of Agilent VEE and
Agilent VSA software.

Measurement Cabinet

The measurement cabinet is a two bay rack comprised of two sets of control,
receive, and transmit equipment. This equipment supports the concurrent
execution of the measurement functions described in the Symtx N1891A-2 PTS
Measurement Reference guide. See the system supplied hardware drawings for
details and diagrams.

Symtx N1891A-2 PTS User’s Guide



Getting Acquainted with the System 1

Operating the Symtx N1891A-2 Payload Test System (PTS)

Operating the PTS includes a variety of tasks from unpacking the system to
developing tests. This section provides a brief overview of how the system
works.

System user types

Four different user types may work with the system at one time or another, as
described in this section.

System installer

Unpacks and sets up the system.

Verifies that the software is installed and configured properly on the PTS
server computer and the measurement computer.

Runs the system functional test (SFT).

Test operator

Periodically runs the SFT to verify that the system is working properly.
Runs calibrations to enhance measurement accuracy.

Tests the test article for a given phase using the tests defined by the test plan
developer.

Runs the system (automatic local operation) using the Symtx N1891A-2 PTS
graphical user interface (PTS GUI), the test conductor control computer
(automatic remote operation), or by direct control of specific instruments (manual
control).

These tasks are discussed in this user’s guide.

Test plan developer

Makes configuration changes.

Uses the PTS GUI to add test article and phases.
Defines each test for a particular test article and phase.
Edits supporting text files that define test parameters.
Defines data presentation formats.

These tasks are discussed in this user’s guide.
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Getting Acquainted with the System

System administrator

» Performs regular maintenance and upkeep of the Windows server
» Performs backups for the PTS and measurement computer

* Archives data

» Installs software upgrades and patches

* Adds and removes users

Modes of operation

You can operate the system in remote or local mode.
Remote mode

When the PTS server computer is under the control of the test conductor control
computer, it is in remote mode.

In remote mode, you can perform tests concurrently by assigning each test to a
different hardware set.

Local mode

When the PTS server computer is under the control of the PTS GUI, either at the
PTS server computer or at the measurement computer, it is in local mode.

In local mode, you can perform tests concurrently by assigning each test to a
different hardware set.

To change the local/remote mode of operation

Use the PTS GUI to place the cabinets in local or remote mode.

To change the mode of operation

Step

1 Inthe PTS GUI main window, choose System Control > Local/Remote.
2 Select a cabinet for which you want to change the mode.

3 Select the desired mode:
* Local for PTS server computer control computer
* Remote for test conductor control computer

Symtx N1891A-2 PTS User’s Guide
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REMOTE MODE Test
Test Conductor Conductor
Computer Control Computer
| I
Customer LAN
LOCAL MODE
System Control
PTS
Server
Computer
| | |
LAN Switch
|
Measurement
Cabinet

Measurement
Computer

n1891a_sys_control.ai
rev7 12/30/2003

Figure 1 Symtx N1891A-2 PTS modes of operation
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Manual control

* Switch matrixes
You can control the system switch matrix using a control menu in the PTS
GUI. See “Using the Switch Matrix Control Window" on page 25.

» Agilent 89600 vector signal analyzer (VSA)
You can control the VSA from the measurement computer.

* Instrument front panels
All other instruments can be manually controlled from their front panels.

If instruments have been set to remote mode by the measurement computer,
they may not respond to key presses. You must first press the Local key to
return the instrument to local mode.

Simultaneous measurements

The Symtx N1891A-2 PTS has the ability to execute two simultaneous
measurements as long as they are using different uplink and downlink ports. For
this case, the side 1 transmit and receive asset is assigned to a set of uplink
ports and side 2 assets the other uplink and downlink port. The system expects
the stimulus port and the receive port, for any particular measurement, to be
designated to the same side assets.

Although the hardware has the ability to support cross-strapping, where side 1 is
the sourcing hardware and side 2 is the receiver hardware, the current software
will not support cross-strapping.

Symtx N1891A-2 PTS User’s Guide
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This chapter describes the login procedures, as well as how to use the online
help system, and the Symtx N1891A-2 PTS graphical user interface (PTS GUI).
It also tells you how to initialize and shut down the system. Finally, it provides
instructions for using the switch matrix control window.
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2  Getting Started

Starting and Logging Into the Computer

20

Use the following procedure to log into the PTS server computer.

To start and log in to the computer

Step

Notes

1

Start the PTS server computer by
pressing the ON/OFF button on the
front of the CPU.

Press Ctrl-Alt-Delete to display the
login dialog box.

In the User name: text area, enter
your login name.

In the Password: text area, enter
your password.

Click OK.

From the Start menu, choose
Programs >N1891AEXX

Turn the measurement computer
and cabinet instruments ON.

The computer takes a few minutes to start.
Make sure the monitor is turned on.

If the dialog box is already displayed, skip
this step.

The Windows desktop appears and you are
logged in.

You can also click the N1891A icon on the
desktop.

The payload test system’s graphical user
interface—the PTS GUI—appears.

The measurement computer uses an
auto-logon process and does not require
the user to log on.

Symtx N1891A-2 PTS User’s Guide



Using the Online Help System

Getting Started 2

System-level documentation is online in Adobe Acrobat format. Clicking HELP
starts Adobe Acrobat Reader and displays the documentation index page.
Figure 2 shows the Adobe Acrobat tool bar while Table 1 gives pointers for using

the online documentation.

Hyperlinked
contents
view Zoom Page Go
tool buttons back Go

Single-column
view

—L

forward Find

/ ya

||[_[| oy @] 1]« ] «| D|m|m| e

n1891a_adobe_acro_tool_sc.ai
rev28/20/03

T

Page viewing
options

Figure 2 Adobe Acrobat tool bar for online help

Table 1 Using the online help system

Task

Results

To view hyperlinked contents:

1 Click the hyperlinked contents view
button.
2 Click any topic in the list.

To expand lower-level topic lists:

1 Click the small triangle shown in the
contents column.
2 Click any topic in the list

To print an online help topic:

1 Choose File > Print.

2 Select a printer and set properties.

3 Select ALL, Current Page, or a
range of pages.

4 Click OK.

* The contents column appears. A
triangle next to a topic shows that
there are lower-level topics

* The lower-level contents list expands

Symtx N1891A-2 PTS User’s Guide
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2  Getting Started

Using the PTS Graphical User Interface (PTS GUI)

Figure 3 shows the PTS GUI, the key way you interact with the Symtx N1891A-2

PTS—both hardware and software. Refer to this figure and Table 2 for
instructions on using the PTS GUI.

*, Agilent N18914 E10 =10fx]
Menu B—Lﬁstm Control Logger Window Help
Syste m. tree q - System Status \nfnrmatilnn Stop
view window = L o HS (@ v poe G button
Hardware i E izz:zcmg 12413/2003 130853 1 Commect 1 sever
(_:onfiguration/ i £ CalCoriia FTSSEAVER
IcCO CaHwConf.prm 12/19/2003 12:06:53 [I] Request System
Cabinet ) F ow_source_preset it Status
icon B: K
{8 UHwConk prm S I
Config file : £ Uplinksafe.t ystem log
icon AT window
TeSt Libra ry// = gAT-Pﬁ Accuracy_Yerfication
Icon [ (B DelayVerty
i DelayvsFrequency.fcf
Delay¥sFrequency. ipf
Delay¥sFrequency. msg
-[2] DelaysFrequencyf |
- DelayysFrequency. stf
<[] DelayvsFrequency.tif
E vsaverson
@ DLPortPowerverfy
@ FrequencydcouracyVerify =
. G DD |>|—|_
System Server Host: E11-PTSSERVER |F\ack1 E11RACK A
n1891a_GUI_main_window.ai
rev2 12/26/03
Figure 3 PTS GUI main window
Table 2 Using the PTS GUI main window
What it is What it does or indicates
Menu bar * Contains menus to control the system, view or print results, log file control, and
view online manuals.
System tree view ¢ Contains the hierarchical representation of asset configuration, test article,

window phases, test, and test definition file icons.

System status bar * Shows the current status of tests on each cabinet connected to the system.

Syztemn Status Information

C5vst E|$ Rurning | 2demaTEST
| I I n1891a_system_status_bar_sc.ai
| | | revl 12/17/03
Cabinet host Local/remote Text status Currently selected
name mode indicator indicator test
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Getting Started

Table 2 Using the PTS GUI main window (continued)

2

What it is What it does or indicates

Cabinet host name ¢ Shows the host name of each measurement computer connected to the PTS
server.

Mode indicator ¢ Shows blue if the system is in local mode (system control/stand-alone control) or

orange if in remote mode (test controller control).

Test status indicator e« Shows the status of the currently loaded test.

@ Not Avail * No test is loaded. Clear by loading and running a
test.

% Running * Test is loaded and running.

@ Idle * Test is finished and can be run again.

m Pause ¢ Test has paused.

System log window ¢ Displays a running log of test activities.

Symtx N1891A-2 PTS User’s Guide
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2  Getting Started

Initializing and Shutting Down System Control

Initializing the system:

Terminates any active tests and places all cabinets in a safe state. Before you
initialize the system, be sure no one is running tests on any of the cabinets.

» Reloads all configuration information.
Shutting down the system:

* Terminates any active tests and places the cabinet in a safe state.
» Affects all cabinets specified by the action. Before you shut down the system,

be sure no one is running a test on any of the cabinets.

To initialize the system

To initialize the system

Step Notes
1 From the PTS GUI, choose e Terminates without additional warning any
System Control > Initialize. test running on any connected rack and

reloads configuration information.

To shut down the system

To shut down the system

Step Notes
1 From the PTS GUI, choose System ¢ Or click the Stop button on the PTS
Control > Stop. GUL.
2 From the Shutdown submenu, choose a ¢ Terminates all tests without additional
specific cabinet or All Racks. warning.
e Does not initialize the selected
cabinets.
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Getting Started 2

Using the Switch Matrix Control Window

The switch matrix control window is available from the PTS GUI. Its main
functions are described in Table 3. Detailed descriptions of uplink and downlink
control functions are given in Table 4 on page 26 and Table 5 on page 28,
respectively.

Table 3 How to use the switch matrix control window

Function Description Steps Notes

Open the 1 From the PTS GUI, choose * The switch control dialog box
switch System Control > Switch Matrix. for that cabinet appears.
control 2 Select a cabinet.

window

Control - Rack Nama

Elcowniisk. merix
plimk Haneds Drmlink Hands

Digwnlink PM inpst
Cipwmiink FM Aoy

- Downlink IF Power Meter Inpet
pd IFFMR Ingut [catbaton =]
Federence Control
e ... b ;
Tkt r—
WVEACHI Input

Uplink Pawet Metes Path VIACHE it

it P Wstir

Liplinik FM Aten

Flscwome Pat
Modubntion Fath

Madsshon Source

Madletion Inpet

I Synthesizar 7 Anensntion

10_dl) Stop Attan S
1_di Step Anien b

Get current Retrieves the 1 Click Get Current Path to read * The system does not update
paths current switch the current settings for the switch path settings automatically;
matrix settings. matrix. you must click Get Current
2 Click the drop-down list box to Paths to retrieve the current
view and select settings. settings.

* For uplink and downlink
options, see Table 4 and
Table 5, starting on page 26.
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2  Getting Started

Table 3 How to use the switch matrix control window (continued)

Function Description Steps Notes
Apply Applies changes ¢ Click Apply. * When you change a setting,
you make in the the entry field. When you click
entry fields. Apply, the settings are
applied and the background
changes back to white.

* Changes to switch settings
cannot be made while a test is
running or paused.

Help Starts Acrobat * Choose Help > Start Help.
Reader and
opens the system
manuals in .pdf
format.
Exit Closes the * Choose Action > Exit to close the ¢ Ifyou close the window before
window. Switch Control window. you click Apply, all changes

are lost.

Table 4 Switch matrix uplink control functions

Function group Function Options Description
Uplink Bands Uplink Bands 0.1t0 2.0 GHz This path must be selected if the frequency of the
signal routed to the uplink ports is in the 0.1 to
1 GHz range.
1t0 19.5 GHz This path must be selected if the frequency of the
signal routed to the uplink ports is in the 1.0 to
19.5 GHz range.
RF Source Source RF Source 1 RF source stimulus 1
Selection
RF Source 1 and RF source stimulus 1 and 2 combined
2
Ext RF Source In  External source stimulus.
Step Attenuator 0to 11 Attenuation value to be applied.
External IN Apply external amplification.
Amplifier
P ouT Remove external amplification.
Uplink 20 dB 20 dB Pad IN Add the 20 dB pad.
Pad
ouT Remove the 20 dB pad.
26 Symtx N1891A-2 PTS User’s Guide
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Table 4 Switch matrix uplink control functions (continued)

Function group Function Options

Description

Receiver Gain Adjustment THRU No pad or amplification when monitoring an uplink
Channel 1 signal to a receiver.
25dB Add amplification when monitoring an uplink signal
AMPLIFIER IN to a receiver.
20 dB PAD IN Add a pad when monitoring an uplink signal to a
receiver.
Receiver 1 Input VSA Channel 1 In Route uplink signal to VSA channel 1.
Detector Video In Route to detector video to VSA channel 1.
External VSA Route external uplink signal 1 to VSA channel 1.
Channel In
Spectrum Route uplink signal to spectrum analyzer.
Analyzer
VSA External RF Source 1 RF Source 1 settled to VSA Trigger In.
Trigger Settled
RF Source 1 RF Source 1 Event 1 out to cabinet rear panel.
Event 1 Out
Ext Source External Source Settled to VSA Trigger In.
Settled
Ext Event 1 In External Event 1 to VSA Trigger In.
Power Meter Connect to Power Meter reference to CH A sensor.
50 MHz
Reference
Signal Uplink signal to CH A sensor.
Uplink Port Uplink Port UL Port 1 Route uplink signal to Port 1.
UL Port 2 Route uplink signal to Port 2.
UL Port 3 Route uplink signal to Port 3.
UL Port 4 Route uplink signal to Port 4.
UL Port 5 Route uplink signal to Port 5.
UL Term Terminate uplink signal.
Source Out Route uplink signal to External Source Out.
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Table 5 Switch matrix downlink control functions

Function Function Options Description
group
Downlink Downlink 0.1t0 1.0 GHz This path must be selected if the frequency of the
Bands Bands signal routed to the downlink ports is in the 0.1 to
1 GHz range.
11t019.5 GHz This path must be selected if the frequency of the
signal routed to the downlink ports is in the 1.0 to
19.5 GHz range.
Receiver Gain THRU No pad or amplification when routing Downlink Signal
Channel 2 Adjustment to a receiver.
25dB Add pad or amplification when Routing Downlink
AMPLIFIER IN Signal to a receiver.
20 dB PAD IN Add a pad when routing Downlink Signal to a receiver.
Receiver 2 VSA Channel 2 Route Downlink Signal to VSA channel 2.
Input

Detector Video
In

VSA Channel 2
to Aux In

Spectrum
Analyzer

Route Detector Video to VSA channel 2.

Route the AUX in signal to VSA CH 2.

Route Downlink Signal to spectrum analyzer

Power Meter

Connect to 50
MHz Reference

Route Power Meter reference to CH B sensor.

Signal Route Downlink Signal to CH B sensor.
Downlink Port Downlink Port DL Port 1 Route Downlink Signal to Port 1.

DL Port 2 Route Downlink Signal to Port 2.

DL Port 3 Route Downlink Signal to Port 3.

DL Port 4 Route Downlink Signal to Port 4.

DL Port5 Route Downlink Signal to Port 5.

UL to DL Pass
Thru

Route Uplink Signal to Downlink pass thru.

28
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3 Running Tests, Viewing Data, and Printing Results

Working with the Test Control Window

Test control window

The test control window handles various testing tasks, from starting tests to
controlling the display of results.

Figure 4 shows the test control window, while Table 6 describes its functions.

Figure 4 Test control window

Table 6 Test control window functions

REE
M enu ba r Test Logger Help T |
Testcontrol . » [ p [ b | = % | & (lestlog
buttons start | Pause | Resume | abort Clear Log | Prirt Log control buttons
pper.ator . — Operator Identification - Test Status
identification _ 5= ‘
text box ] ﬁ Test status
- . ~ Test Configuration TNl ndow
Lzslgg?gﬂgg Lastm-p Display Results [™ Perform Standard Telemetry
v Perfarm Limit Checking [ Perform Intermediate Telemetiy Test Loaded
[ Print Results
[Parameter Name Parameter Value Unit
ActiveTest 1
TestName GainAdjustment_FixedGain
Parameter Phase. hMeasurement_Demonstratio
setti ngs Testaricle ATF
text boxes UUTCFG CC_MNamGainMB_GCMOP
InputFort USE_ULFM
OutputPort USRE_DLFM
InputFrequency 6703000000 Hz
OutputCenterFreguency 3653000000 Hz
InputReterencePower -394 dBEm
InputOffs etPower =15 db
RetControlState dB
ControlState 357 db
ControlStateSafe dB
|
12192003 1316:37 [1] Gainddiustment_FixedGain: Load Test
Testlog |
window
n1891a_test_control_funct.ai
rev2 12/26/03

Function

Description

Notes

Menu bar

Test control
buttons

Clears or unloads the current test,
or loads a new test.

Starts, pauses, resumes, or aborts
the current test.

* Choose Test > Load Test from the menu bar
as an alternate to loading a test from the PTS
GUL.

* When you click Pause, the test halts at the
next execution check embedded in the test
plan. If there are no execution checks, Pause
does nothing.
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Table 6 Test control window functions (continued)

Function Description Notes

Test log control Clears or prints the results log for * Print directs the contents of the test log to the

buttons the current test. Windows default printer.

Operator Permits only registered operatorsto ¢ You must enter a valid operator identifier to

Identification text run tests. run a test.

box

Test status Reports the status of the current * See “Test status indicators" on page 33.

window test.

Test Controls automatic display of test

Configuration results, limit checking, and some

selection buttons telemetry functions.

Parameter Sets specific parameters for the * You can enter values only in fields with a white

settings text test. background; others have been locked by the

boxes test plan developer.

Test log window Records test events. * Use the test log control buttons to clear or print
the log.

Terminating vcontrol.exe isolates the test window

The system runs tests using VEE and vcontrol.exe on the measurement
computer. If vcontrol.exe terminates abnormally (because a user kills the
process or because of an internal error) when VEE is running a test, it severs the
connection between the PTS GUI and the test being run.

If this happens, you will not be able to use the test control window, nor
close it using normal methods.

To recover from this condition start vcontrol.exe by clicking on the control icon
on the measurement computer display.
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Running Tests

Once you have become familiar with the various user interfaces, you can begin
running tests on the Symtx N1891A-2 PTS.

To run atest

To run a test

Step Notes

1

Click the N1891A PTS icon on the
desktop.

In the PTS GUI, expand the Test
Library, the desired test article,
phase, and testID.

* You also can start the test control program

by typing D:\N1891AEXX\bin\gui.exe in
the Run dialog box, or by double-clicking
the Test Control icon in Windows Explorer
or My Computer.

Click the + next to the icon to expand the
tree.

g} Payload Test Equipment

=5 i Hardweare Configuration
+ dz4
+ babylons
Test Library icon ——l—' Tezt Librar_l,l
& DemcDUT
/ e C - C Band Calibrat
Test article icon = ] oL Gmup
D¢
| D
Phase icon -1 Dl:
Dz
TestID icon D':
+ B DL Grnupﬁ:
£ @) DL Loss O, 718018 o test ran sca
+ W UL Group £

Right-click the testID icon, and
choose Load Test from the context
menu.

Enter an operator name in the
Operator Identification text box.

In the test control window, set
parameters by selecting test
configuration options and entering
parameter values.

Click Start to run the test.

* You also can load tests from the test

control window. Choose Test > Load Test.

This operator name must be in the users
file maintained by the system
administrator.

If a parameter is grayed out, it has been
locked; it can be changed only by the test
plan developer.
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Test status indicators

As the test runs, an indicator in the test status window shows the state of the
currently loaded test.

Table 7 Test status indicators

Start Test is loaded and can be run.

Runnin  Testis loaded and running.
g

Pause Test has paused.
Resume Test has resumed running.

Abort Test has aborted.

Stopped Test has finished and can be run again (indicates a valid
TestCompleted message)

©ONT| = AR
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Viewing Data and Printing Results

You can view results as soon as the test completes or at a later time. You can
print test results for more thorough analysis.

To view test results

Check the Display Results box in the test control window for test results to
appear automatically in the test log window when the test is finished. You also
may view test results later, or view results of a test other than the current test.
You may also view a test log containing detailed information about events that
occurred during the test.

To view test results

Step Notes

1 Inthe PTS GUIright-click  * This is the testID icon for the test results you want to
the testID icon. view.

2 Choose View Test Results
from the context menu.

3 Select one of the testresult ¢ File names are identified by the time the data was
files. created. The format is MMDDYY_HHMMSS _|.
* MM = two digit month
e DD = two digit day
* YY =two digit year
* HH = two digit hours
* MM = two digit minutes
* SS = two digit seconds

e | = port sequence index
4 Click OK. * The first page of the presentation appears.
5 Select one of the test log * Test log files have the same file name format as
files result files, but end in.log.
6 click OK * The log file text appears.
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To print results

To print test results to the Windows default printer when the test is finished, open
a presentation. Be sure the printer is turned on, connected via the LAN, and has

paper.

You also may print test results later or print results of a test other than the current
test.

To print results

Step Notes

1 Open a presentation.
2 Click Section.

3 Click Print or choose Test > Print e Output is directed to the Windows
Current Section to print the current default printer.
page. Choose Test > Print All to print all
pages in the presentation.
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Simulating Measurements

Measurement simulation can be used to debug PSMs and local test files (for
example, msg and .Ipf) when PTS hardware or the device under test is not
available. Measurement simulations validate the input parameters and
generated simulated outputs, but do not control or read any PTS hardware.

Simulated output data are pre-defined and do not change with input parameters.

Simulated measurements are enabled by setting the SimulateTest parameter in
the LPF file to 1, (see the Symtx N1891A-2 Measurement Reference guide for details
on this parameter).
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Using the Event Retriever

The Event Retriever is a separate PTS application, which gives an ongoing
report of system events. This information provides a comprehensive view of all
testing activity; in essence it compiles the information from the PTS GUI main
window and any test control windows in a single interface.

You open the Event Retriever’s browser window by double-clicking the Event
Retriever icon on the Windows desktop. Using the menus and navigation
buttons, you can view and manipulate the data. Figure 5 shows the Event
Retriever browser, which is described in the table on the following page.

% Agilent N1891A -Event Browser

File Edit

28/05/2002 17:25:00 [I]WEECOWNTROL

28/ 09/2002 17:23:02 [D] wWiIN32
26/05/2002 17:31:41 [I]YEECONTROL

28/ 05/2002 17:35:09 [I]YEECONTROL

28/ 05/2002 17:35:11 [D] WwWiN32
28/ 05/2002 17:37:36 [[]YEECONTROL

28/ 05/2002 17:37:40 [D] wWiN32
28/05/2002 17:37:40 [D] WIN32
28/05/2002 17:37:40 [D] WAN32
28/ 09/2002 17:37:40 [D] wWiN32
28/ 05/2002 17:37:40 [D] wWiN32
28/05/2002 17:37:40 [D] WIN32
28/05/2002 17:37:40 [D] WAN32

28/ 05/2002 17:37: 40 (NYEECONTROL
4

RTWNO3 STARTED test. 200422 ToF
Fitn_L2_abzPwrCalvPI0_007 on rac
RTHOZ at 052802_17:29.00 EID: ‘rtrl
5052040

) . Page Up
RTHO3 The system cannot find the file

specified.

ATHO3 COMPLETED test. 200423
Rtn_L2_AbsPuwCal-WF3I0_007 on rac
ATHO3 at 052802_17:31:41 with stat,
Pa5S5:052802_172900 EID: 'th03' 50

240"
e |
RBTHO3 STARTED test, 20042

Fitn_lnstrumentCalibration_007 on rac
RTHO3Z at 052802_17:35%09 EID: ‘iinl
5052040

RTHO3 The system cannot find the File
specified.

RTHO3 COMPLETED test. 2004e3
Fitr_lnstrurmentCalibration_007 on rac
RTHO3 at 052802173736 with stat.
DOME:052802_173509 EID: 'tn03" 5(
2040"

RTMO3 The system cannot find the pz
specified.
RTNO3 The system cannat find the file ; Down
specified,
RTHNO3 The system cannat find the File
specified.
RTMO3 The system cannot find the File
specified.
RTMO3 The system cannot find the File
zpecified.
RTHO3 The system cannaot find the File
specified,
RTHO3 The system cannot find the file
specified.

RTHO3STARTED test, 200412 _blll BOTTOM

Page Dn

Mo maore events awailable

Figure 5 Event Retriever browser window
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Table 8 Event retriever browser window components

What it is What it does or indicates

Menu bar (top) * Contains File and Edit menus with commands to save, print, copy to
the Clipboard, and clear the data from the Event Retriever.

Navigation scroll bar and * Continuous scrolling of the text (Up and Down buttons) or moving by

buttons (right) pages (Page Up and Page Dn).

* Jump to the top or bottom of the file (Top and Bottom buttons).
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4 cCalibrating the System

Introducing Calibrations

40

The purpose of calibrating the Symtx N1891A-2 PTS is to enable the system to
provide accurate measurements at a defined interface with the payload. The
PTS can provide corrected measurements at the calibration interface or at the
Unit Under Test (UUT) interface:

Calibration Interface - This is defined as the point where calibration reference
devices (such as power sensors or diode detectors) are connected. The PTS
calibration routines create system calibration files containing gain or delay
measurements between the measurement cabinet instruments and the
calibration interface. The system calibrations will then be applied to payload
measurements to correct instrument readings to the calibration interface
point. Note that if this is the point where the UUT connects to the PTS, then
this also defines the UUT interface.

UUT Interface - If the UUT does not connect directly to the calibration
interface (that is, there is additional cabling between the calibration interface
and the UUT interface), then external hardware calibration files must be
configured to enable the PTS to correct its power and delay measurements
out to the UUT interface. The external hardware calibration files are
mathematical models of the transmission path gain and delay between the
calibration interface and the UUT interface. Note that the user, not the PTS
software, creates the external hardware calibration files.

The PTS calibrations consist of five elements:

1

2

System Calibrations - These calibrations measure the gains and delays of the
RF paths and measurement cabinet instruments. They fall into two sub
categories:

Port Calibrations - These calibrations measure the gain and delay
between the measurement cabinet instruments and the calibration
interface. Port calibrations require reference devices such as power
sensors or diode detectors to be connected to the calibration interface.
Port calibrations can be sequenced to provide calibration files for all the
uplink and downlink ports of the PTS.

Internal Calibrations - These calibrations measure the gain of RF paths
within the measurement cabinet and include measurements of the
downconverter and spectrum analyzer power readings vs. internal power
sensors. Since no external reference devices are required to run the
internal calibrations, the PTS can be connected to the UUT while they are
being run.

Instrument Calibrations - These are standard calibration or zeroing routines
present in the instrument firmware. The PTS software initiates these routines
on a timed basis using “chore functions”. The instrument calibrations can be
run while the PTS is connected to the UUT.

External Hardware Calibrations - These are either user-supplied files or files
created by executing the payload and antenna coupler calibrations. These
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files contain the gain and delay that models the characteristics of cables,
adaptors, couplers, etc. that are located between the calibration interface and
the UUT interface.

4 Other Hardware Calibrations - Noise source ENR calibration tables are
required for Noise Figure measurements.

5 Time and Temperature Drift Calibrations - These are calibrations that are
performed to characterize the drift in the cables connected to the UUT over
time and temperature. The amplitude offset due to drift is calculated and
stored for future reference by the measurements.

The following paragraphs contain information on the types of calibrations, how to
configure them, and how to schedule their use.
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System Calibrations

The Symtx N1891A-2 PTS requires system calibrations prior to and during the
use of the system. The system calibrations consist of port calibrations, internal
calibrations, external calibrations, and time and temperature drift calibrations.

Port Calibrations

The port calibrations required by the PTS measurements are:

Uplink Port Gain Calibration - The purpose of the Uplink Port Gain
Calibration is to measure the insertion gain of the uplink path between the
PTS rack and the UUT interface for a specified uplink port.

Downlink Port Gain Calibration - The purpose of the Downlink Port Gain
Calibration is to measure the insertion gain of the downlink path between
the UUT interface and the PTS rack for a specified downlink port.

Uplink Delay Calibration - The purpose of the Uplink Delay Calibration is to
measure the delay of the uplink path between the PTS rack and the UUT
interface for a specified uplink port.

Downlink Delay Calibration - The purpose of the Downlink Delay
Calibration is to measure the delay of the downlink path between the UUT
interface and the PTS rack for a specified downlink port.

For more details on the port calibration routines, consult the Symtx N1891A-2
Measurement Reference guide.

Internal Calibrations

The internal calibrations required by the PTS measurements are:

Downconverter RF Gain Calibration - The purpose of the Downconverter
RF Gain Calibration is to measure the insertion gain of the downconverter
path between the uplink/downlink power sensors and the Vector Signal
Analyzer for specified uplink/downlink frequency ranges.

Receiver Amp/Pad Gain Calibration - The purpose of the Receiver
Amp/Pad Gain Calibration is to measure the insertion gain of the receiver
switched amplifiers and attenuators (pads) relative to the through path for
specified uplink/downlink frequency ranges.

Spectrum Analyzer Gain Calibration - The purpose of the Spectrum
Analyzer Gain Calibration is to measure the insertion gain of the downlink
path between the downlink power sensor and the Spectrum Analyzer for
specified downlink frequency ranges.

For more details on the internal calibration routines, consult the Symtx N1891A-2
Measurement Reference guide.
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External Calibrations

The external calibrations required by the PTS measurements are:

Payload Port Loss Calibration - The purpose of the Payload Port Loss
Calibration is to measure the loss between the payload test port and the
payload interface for a specific UUT port.

Antenna Port Loss Calibration - The purpose of the Antenna Port Loss
Calibration is to measure the loss between the antenna test port and the
antenna interface for a specific UUT port.

For more details on the internal calibration routines, consult the Symtx N1891A-2
Measurement Reference guide.

Time and Temperature Drift Calibrations

The time and temperature drift calibration required by the PTS measurements
are:
Thermal Vacuum Calibration - The purpose of the Thermal Vacuum

Calibration is to characterize the amplitude and phase changes of the
cables connected to the UUT over time and temperature.

For more details on the internal calibration routines, consult the Symtx N1891A-2
Measurement Reference guide.
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44

Configuring System Calibrations

The system calibrations require the same support files as any PTS test:
* Program Schedule Message (.msg)

» Local Parameter File (.Ipf)

» Test Limit File (.tlIf)

» Standard Telemetry File (.stf)

* Rules Lookup File (.rlf)

» Format Control File (.fcf)

For more details on the contents of these files, consult the Symtx N1891A-2
Measurement Reference guide. Template versions of these files can be found in the
N1891AEXX\etc\templates directory. For details on adding and defining these
support files, see Chapter 7, “Adding and Defining Tests and Calibrations”.

Calibration Frequency Configuration Files

System calibrations also require the following Calibration Frequency
Configuration Files:

ULCalFreqConf.prm - defines the calibration frequencies for the uplink
ports

DLCalFreqConf.prm - defines the calibration frequencies for the downlink
ports

The Calibration Frequency Configuration Files provide a central location for
configuring the frequency ranges of the system calibrations. These files are
located in the

\N1891AEXX\etc\rack_name\CalConfig\CalSet_name\ directory. The following
are examples of ULCalFreqConf.prm and DLCalFreqConf.prm files. Each file
contains:

Frequency Band Definitions - Including start, stop, and step frequency
ranges.

Port Definitions - Including the band names that will be calibrated for each
port.

It is necessary for the downconverter gain calibrations (INTCHZ1, INTCH) to
include all of the frequency ranges specified in the port calibrations (SSU_ULPxx
and SSU_DLPyy). Also, it is required that there is no frequency overlap between
any of the bands used in this file.
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Example ULCalFreqConf.prm File:

HHHHHHHHHAFH A A R R R R R
N1891A Payload Test System

Uplink Calibration Frequency Configuration
ULCalFreqgConf.prm

Copyright 2006 Symtx, Inc., All rights reserved.

H o H H HF H H

HHHHHHHHHAFHH A H A H A A A A A A R

# Revision:

# SHeader:
/N1891AEXX/etc/E10RACK/CalConfig/Default/ULCalFreqConf.prm 8
12/01/03 3:24p Gopalk $

#

#

HHHHH A HH AR H S A R R R R R
This file defines the uplink calibration frequencies

The frequency definition mechanism is as follows:

+H

The frequencies are defined by custom user bands that are specified
using four parameters that are equal sized arrays

ULFregBands defines the band names

ULFregBandStart defines the band start frequencies
ULFregBandStop defines the band stop frequencies
ULFregBandStep defines the band step frequencies

Each Port is then configured to include one or more bands. The
port names used in the system reflect the internal port names and
not the user defined labels (C-UP etc)

Each Port's frequency definition is broken up into three parts as
Amplitude Bands
Delay Bands
CenterFreqgs (optional)

The PortName Amplitude Bands define the calibration bands for the
gain calibrations

The PortName Delay Bands define the calibration bands for the delay
calibrations

The PortName CenterFreqgs defines discrete frequencies of interest
for which a calibration point is desired.

For general Non-Port calibrations such as internal Rcvr Pad Amp and
Downconverter gain cals, a pseudo-port "INTCH1" is used

FH o o H o H O H H HH H O HH O HHHHHEHHHEHHHEH
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i ki s d s a ki a ki ninizininini

String ULFregBands {“WIDE” “WIDE2” “LOW” “L_UP” “MID” “C_UP_5M” “C _UP 2M” “HI” }
double ULFregBandStart {1000e6 1000e6 1000e6 1618.5e6 1700e6 6325e6 6325e6 6900e6 }
double ULFregBandStop {19500e6 19500e6 1600e6 1668.5e6 6300e6 6825e6 6825e6 9500e6 }
double ULFregBandStep {100e6 250e6 100e6 2e6 100e6 5e6 2e6 100e6 }

#

# Port 1 Definitions

#

string SSU ULP01 Amplitude Bands{ "C_UP_5M" }
string SSU ULP0l1l Delay Bands { "C_UP_5M" }
double SSU ULPOl CenterFregs { 6708e6 }

#

# Port 2 Definitions

#

string SSU _ULP02 Amplitude Bands { "WIDE" }
string SSU_ULP02_Delay Bands { "WIDE2" }

#

# Port 3 Definitions

#

string SSU ULP03 Amplitude Bands { "L _UP" }
string SSU ULP03 Delay Bands { "L _UP" }
double SSU ULP03 CenterFregs{ 1643.5e6 }

#

# Port 4 Definitions

#

string SSU_ULP04_Amplitude Bands { "WIDE" }
string SSU_ULP04_Delay Bands { "WIDE" }
#

# Port 5 Definitions

#

string SSU ULPO5 Amplitude Bands { "MID" }

string SSU ULP05 Delay Bands { »mID" }

double SSU ULP05 CenterFregs { 3683e6 }

#

# The INTCH1 pseudo-port name is used for all internal RcvrChl (UL)

# calibrations such as Rcvr Pad Amp and Downconverter Gain calibrations
#

string INTCH1 Amplitude Bands{ "LOW" "L UP" "MID" "C_UP_2M" "HI"

double INTCH1 CenterFregs { 1643.5e6 3683e6 6708e6 |
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Example DLCalFreqConf.prm File:

FHEH R

# N1891A E10 Payload Test System
#

# Downlink Calibration Frequency Configuration
#

# DLCalFregConf .prm

#

# Copyright 2006 Symtx, Inc., All rights reserved.

#

HHHHHHHHHAFHH A HASHH A A A A A A

# Revision:
$Header:/N1891AEXX/etc/EXXRACK/CalConfig/Default/DLCalFregConf.prm 7
12/01/03 3:24p Gopalk $

#

#

HHHHHHHHH S H A A R R R R R

This file defines the downlink calibration frequencies

The frequency definition mechanism is as follows:

+H

The frequencies are defined by custom user bands that are specified
using four parameters that are equal sized arrays

DLFregBands defines the band names

DLFregBandStart defines the band start frequencies
DLFregBandStop defines the band stop frequencies
DLFregBandStep defines the band step frequencies

Each Port is then configured to include one or more bands. The
port names used in the system reflect the internal port names and
not the user defined labels (C-UP etc)

Each Port's frequency definition is broken up into three parts as
Amplitude Bands
Delay Bands
CenterFreqgs (optional)

The PortName Amplitude Bands define the calibration bands for the
gain calibrations

The PortName Delay Bands define the calibration bands for the delay
calibrations

THe PortName CenterFreqgs defines discrete frequencies of interest
for which a calibration point is desired.

For general Non-Port calibrations such as internal Rcvr Pad Amp and
Downconverter gain cals, a pseudo-port "INTCH2" is used

FH o o o H o H H o H O HHHHH O HHHHHHFHHHFH
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i ki s d s a ki a ki ninizininini

String DLFregBands {“WIDE” “WIDE2” “LOW” “L_Up” “MID” “C_UPp_5M"” “C_UP_2M” “HI” }
double DLFregBandStart {100066 1000e6 1000e6 1517.5e6 1600e6 3300e6 3300e6 3800e6 }
double DLFregBandStop {1950066 19500e6 1500e6 1567.0e6 3300e6 3800e6 3800e6 19500e6 }
double DLFregBandStep {100e6 250e6 100e6 2e6 100e6 5e6 2e6 100e6 }

#

# Port 1 Definitions

#

string  SSU DLP0l Amplitude Bands { "c bn_sM" }

string  SSU DLP01 Delay Bands { "c_ DN sM" }

double SSU DLPO1 CenterFregs { 3683e6 }

#

# Port 2 Definitions

#

string  SSU DLP02 Amplitude Bands { "wiIDE" }

string SSU DLP02 Delay Bands { "wipe2" }

#

# Port 3 Definitions

#

string  SSU DLP03 Amplitude Bands { "» DN" }

string  SSU DLP03 Delay Bands { "r DN" }

double SSU DLP03_ CenterFregs { 1542e6 }

#

# Port 4 Definitions

#

string  SSU DLP04 Amplitude Bands { "wiIDE" }

string  SSU DLP04 Delay Bands { "wIDE" }

#

# Port 5 Definitions

#

string  SSU DLP0O5 Amplitude Bands { "c_DN sM" }
string  SSU DLP05 Delay Bands { "c_DN sM" }
double SSU DLP05_ CenterFregs { 3683e6 }

#

# The INTCH2 pseudo-port name is used for all internal RcvrCh2 (DL)
# calibrations such as Rcvr Pad Amp and Downconverter Gain calibrations

string INTCH2 Amplitude Bands{ "LOW" "L DN" "MID" "C_DN 2M" "HI" }
double INTCH2 CenterFregs{ 1542e6 3683e6 }
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#
# Spectrum Analyzer Cal Definitions:

#
string SpectrumAnalyzer Amplitude Bands { "LOW" "MID" "C_DN_5M" "HI"
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Example CalAsset.prm File:

HHHHHHHHHAFH A A R R R R R
N1891A Payload Test System

Calibration Asset
CalAsset.prm

Copyright 2006 Symtx, Inc., All rights reserved.

H o H H HF H H

HAEHHHHEHAHH A HEHSHH A HEH SRS R TS
# Revision:

# SHeader:
/N1891AEXX/etc/E10RACK/CalConfig/Default/CalAsset.prm

#

#

HAEHHHHAHAHH A HEHS R HAH SR H SRS R R A S

# This file defines the (this is a place holder until the next revision!)
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Performing System Calibrations

To perform a system calibration:

Step Notes

1 From the Test Library, expand the file
tree to locate the calibration you want to
perform.

2 Right-click the calibration and choose
Load Test from the context menu.

3 Enter operator name, test configuration,
and parameter value you want to use.

4 Click Start * The test begins.-At completion of the
test, the calibration data is stored in
the \N1891AEXX\Cal\
TestArticle_name\CalSet_name\
Rack_name\ directory. This data
overwrites any existing file with the
same name and will be used for
correction of subsequent payload
measurements.

* An additional copy of the file will be
placed in the \N1891AEXX\Cal\
TestArticle_name\CalSet_name\
Archive\ directory. A unique
timestamp (Thhmmss) will be
appended to the file name to provide
an archive of the calibration data. The
PTS software will NOT overwrite this
file.

The system calibrations do not need to be performed in any particular order.
There is no dependency of one calibration upon the results of another. The only
requirement is that the calibration data files created by the system calibrations
be present on the system when a payload measurement requires them.
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Scheduling System Calibrations

Accurate testing requires that system calibrations occur at the proper times. The
following table describes possible events and the recommended calibrations.

Event

Recommended calibrations

Initial system setup or new environment

Changes in external UUT RF cables (length,

type, flexure)

Dual Downconverter replacement

VSA replacement

Spectrum Analyzer replacement

Uplink or Downlink Power Sensor
replacement

System Switch Unit replacement

> 5 degree C change in environment
temperature from previous calibrations

All system calibrations

Port Gain Cals
Port Delay Cals

Port Delay Cals:
Downconverter RF Gain Cal

Port Delay Cals
Downconverter RF Gain Cal

Spectrum Analyzer Gain Cal

Port Gain Cals-Downconverter RF
Gain Cal

Spectrum Analyzer Gain Cal
All system calibrations

Downconverter RF Gain Cal
Spectrum Analyzer Gain Cal
Thermal Vacuum Cal
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Instrument Calibrations

The following instrument calibrations can be run automatically by the PTS
software:

» Cal Power Meter Zero and Calibrate

» Uplink/Downlink Power Meter Zero and Calibrate
» Vector Signal Analyzer Calibrate

» Downconverter Spot Gain Cal

e Spectrum Analyzer Cal

The instrument calibrations are initiated by Chore Functions that are included in
the software for each test.

Configuring Instrument Calibrations

Setting parameters in the Local Parameter File of a test will configure the Chore
Functions that initiate the instrument calibrations. The following table lists the
LPF parameters that control the instrument calibrations and their possible
settings (“AUTO”, “YES”, or “NO”).

Individual tests may not use all of the instruments and their LPF files would only
include parameters for the instruments they actually use.

LPF Parameter Name Type Description

DoDownconverterCal opt) String If left to “AUTO”, the

Defaults to AUTO if not specified. AUTO, software will perform the
“YES” or Downconverter RF Gain
“NO“ Spot Calibration only when

triggered by the internal
test system timers. For the
most accurate amplitude
and phase accuracy, set
this parameter to “YES”
and the software will be
forced to calibrate the
downconverter at the
beginning of the test. “NO”
will disable any
downconverter calibration
and is not recommended
for achieving specified
measurement accuracy.
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LPF Parameter Name Type Description
VSA DoVSACalibrate (opt) String If left to “AUTQ”, the VSA
Defaults to AUTO if not specified. AUTO”,  will perform a
“YES” or self-calibration only when
“NO* triggered by the internal
test system timers. For the
most accurate amplitude
and phase accuracy, set
this parameter to “YES”
and the VSA will be forced
to self-calibrate at the
beginning of the test. “NO”
will disable any VSA
self-calibrating and is not
recommended for
achieving specified
measurement accuracy.
ULPowerMeter_ DoSetRefPathAndCalibrate String If left to “AUTO”, the power
(opt) AUTO”,  meters will perform a
ULPowerMeter DoSetRefPathAndZero . .
(opt) - “YES” or self-calibration or self-zero
DLPowerMeter DoSetRefPathAndCalibrate “NO“ only when triggered by the
)(gllj.gowerMeter DoSetRefPathAndZero internal test system timers.
(opt) - For the most accurate

CalPowerMeterl DoManualCalibrate
CalPowerMeterl DoManualZero

amplitude and phase
accuracy, set this

Defaults to AUTO if not specified.
P parameter to “YES” and the

power meters will be forced
to self-calibrate or self-zero
at the beginning of the test.
“NO” will disable any
calibrating or zeroing and is
not recommended for
achieving specified
measurement accuracy

Scheduling Instrument Calibrations

If the instrument calibration parameters in the LPF are set to “AUTO?”, the chore
function will initiate an instrument cal at the beginning of a test if the chore
interval for that cal has been exceeded. The chore interval values are contained
in hardware configuration files found in the \N1891AExx\etc\Rack_name\
AssetsConfig\ directory. The following table lists the hardware configuration file
names, parameter names, and recommended chore interval settings.
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Configuration file name

Parameter name

Recommended
chore Interval setting
(hours)

CalPowerMeterlConf.prm

DLPowerMeterConf .prm

ULPowerMeterConf.prm

VSAConf .prm

SpectrumAnalyzerConf.prm

CalHwConf .prm

(Located in the
N1891AExx\etc\Rack_ name
directory)

CalPowerMeterl_ ChorelInte
rvals

ULPowerMeter_ ChoreInterv
als

ULPowerMeter Chorelnterv
als

VSA Chorelntervals

SpectrumAnalyzer Choreln
tervals

DCSpotGainCalInterval

4 (zero)/4 (cal)

8 (zero)/8 (cal)

8 (zero)/8 (cal)
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External Hardware Calibrations

56

External Hardware Calibrations are user-supplied gain and delay files that model
the characteristics of cable between the calibration interface and the UUT
interface.

External Hardware Configuration

PTS measurements can utilize multiple external hardware gain or delay files for
a single uplink or downlink port. For example, an uplink port may have a cable in
series with a directional coupler between the calibration interface and the UUT
interface. The measurement can correct the test results for the loss or delay of
the cable and coupler to generate a measurement result that is accurate at the
UUT interface. The external hardware configuration files (ULExtHWConf.prm
and DLExtHWConf.prm) contain the names of the gain or delay files for all of the
devices connected to a PTS port. The external hardware configuration files can
be found in the \N1891AEXX\Cal\TestArticle_name\CalSet_name\ExtHW\
directory. Below is an example of an uplink external hardware configuration file.

Example ULExtHWConf.prm file

HHHHHHHHHAFH A A R R R R A

# The external hardware configuration is a list of cal files that MUST BE
# present in the \N1891AEXX\Cal\TestArticle name\CalSet name\ExtHW\
directory

#

# External hardware can be defined through the following means

#

# 1. PSM parameter with the user Port label

# eg : User port label = "USR _ULPO1"

# string ULEXTHW_MAG USR ULP01{ "Portl Mag" "PortlPad Mag" }
# string ULEXTHW DELAY USR ULP01 { "Portl Phase"

"PortlPad_ Phase" }

#

# Port Name must be using user port label

#

#

# 2. Define in this DLHWConf.prm file using system port name

# eg : System port name = "SSU ULPO1"

# string ULEXTHW_MAG SSU ULP01{ "Portl Mag" "PortlPad Mag" }
1;& string ULEXTHW _DELAY SSU ULPO01{ "Portl Phase" "PortlPad_ Phase"
#

# PORT NAME MUST BE SYSTEM PORT NAME.

#

HHHHHHHHHAFHH A A R R R A R

string ULEXTHW MAG SSU ULPO1 { "Loss_Coupler Cup"Cal Loss_Cable#3240" }
string ULEXTHW DELAY SSU ULP01 { "Cal Delay Cable#3240" }

string ULEXTHW MAG SSU ULP02{ NULL }
string  ULEXTHW DELAY SSU ULP02{ NULL }
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string ULEXTHW MAG SSU ULP03{ "Loss Coupler Lup" "Cal Loss Cable#2" }
string  ULEXTHW DELAY SSU ULP03{ NULL }

string  ULEXTHW MAG SSU ULP04{ NULL }
string  ULEXTHW DELAY SSU ULP04{ NULL }

string  ULEXTHW_MAG SSU ULP05{ "Cal_Loss_Cable#6" }
string  ULEXTHW_DELAY SSU ULPO05{ NULL }

(The DLExtHWConf.prm file follows the same format.)

External Hardware Calibration Files

The user-supplied gain and delay files are text files containing:
* The number of frequency points in the file
* Frequency and Gain (or Delay) pairs for each point

» The source of the gain or delay data could be a network analyzer
transmission measurement or a measurement performed using the PTS. The
external hardware calibration files should be copied to the \N1891AEXX\Cal\
TestArticle_name\CalSet_name\ExtHW\ directory. The following are
examples of gain and delay calibration files.

Fundamental units are used in the external hardware calibration files (frequency
in Hz, gain in dB, and delay in seconds). Loss is expressed as a hegative gain.
Delay is always positive.

Example Gain file (named Cal _Loss_Cable#3240)

19

100000000 —1.24E+00
149750000 —1.34E+00
199500000 —1.46E+00
249250000 —1.60E+00
249250000 —1.60E+00
299000000 —1.74E+00
348750000 -1.91E+0
398500000 —2.05E+00
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448250000
498000000
547750000
597500000
647250000
697000000
746750000
796500000
846250000
896000000
945750000
995500000

# Created ON 21/Nov/2003 10:24:00

17

1.000E+09
1.006E+09
1.011E+09
1.017E+09
1.023E+09
1.028E+09
1.034E+09
1.039E+09
1.045E+09
1.051E+09
1.056E+09
1.062E+09
1.068E+09
1.073E+09

—2.19E+00
—2.32E+00
—2.44E+00
—2.55E+00
—2.66E+00
—2.77E+00
—2.87E+00
—2.97E+00
—3.06E+00
-3.15E+00
—3.24E+00
—-3.33E+00

4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.89E-08
4.90E-08
4.89E-08
4.89E-08
4.89E-08

From Network Analyzer data

Example Delay file (named Cal_Delay Cable#3240)
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1.084E+09
1.090E+09
1.096E+09

# Created ON 21/Nov/2003 10:24:00
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4

59



4 cCalibrating the System

Other Hardware Calibrations

60

Power Sensor Calibrations

The Symtx N1891A-2 PTS does not require power sensor calibration tables.
Instead, the Symtx N1891A-2 PTS utilizes the Agilent EPM Series power meters
that automatically download calibration data from the sensor to the power meter.

Noise Source ENR Tables

The Symtx N1891A-2 PTS does require noise source Excess Noise Ratio (ENR)
tables for use with the Noise Figure measurement. The ENR table
(NoiseSourceConf.prm) is located in the \N1891AExx\etc\Rack name\
AssetsConfig\ directory. This file can contain multiple ENR tables, each labeled
with a noise source serial number. The Noise Figure test specifies the noise
source serial number in its Local Parameter File (for LPF details, consult the
N1891A Measurement Reference). An example ENR file is shown below.

Example NoiseSourceConf.prm file

HHHHHHHHHAF IS H A HH A A A A A $Header:
/PTSComponents/etc/Rack _name/AssetsConfig/NoiseSourceConf.prm 12/09/03
2:09p Davef S

HHHHHHHHHAFHH A HASHH A A A A A A

# Configuration File for ULMatrix

#
string NoiseSource NoiseSource
string NoiseSource LibName "Driver\\SystemTestAsset.LIB"

double NoiseSource ENRTable 4124A06458

{

0.01e9 5.06
0.10e9 5.01
1.00e9 5.00
2.00e9 5.23
3.00e9 5.18
4.00e9 5.20
5.00e9 5.15
6.00e9 5.12
7.00e9 5.10
8.00e9 5.14
9.00e9 5.21
10.00e9 5.22
11.00e9 5.23
12.00e9 5.22
13.00e9 5.30
14.00e9 5.39
15.00e9 5.57
16.00e9 5.78
17.00e9 5.80
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18.00e9 5.49
}
double NoiseSource ENRTable 4124A05810
{
0.01e9 14.50
0.10e9 14.37
1.00e9 14.01
2.00e9 13.96
3.00e9 13.93
4.00e9 14.01
5.00e9 14.06
6.00e9 14.17
7.00e9 14 .35
8.00e9 14.60
9.00e9 14.98
10.00e9 15.22
11.00e9 15.38
12.00e9 15.46
13.00e9 15.56
14.00e9 15.61
15.00e9 15.45
16.00e9 15.22
17.00e9 14.99
18.00e9 15.01
19.00e9 15.04
20.00e9 15.15
}
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Using Calsets

62

The Symtx N1891A-2 PTS software allows for the creation and use of multiple
sets of calibration data, referred to here as a “calsets”. This allows the test plan
developer to specify the use of a calset for a specific environment such as initial
test or thermovac.

The following table summarizes the locations of the calibration data files on the
PTS server computer hard drive.

Cal data Created Directory path

file type by:

System port PTS D:\N1891AEXX\Cal\TestArticle name\CalSet_name\
cals software ~ Rack_name\

System PTS D:\N1891AEXX\Cal\TestArticle name\CalSet name)\
internal cals software ~ Rack_name\

Instrument cals PTS D:\N1891AExx\Cal\TestArticle name\Chores\

software Rack_name\

External User D:\N1891AExx\Cal\TestArticle name\CalSet name)\

hardware cals ExtHW\ (Both Ext HW Configuration and Cal files
are located here)

Noise source User D:\N1891AExx\etc\Rack name\AssetsConfig\

ENR table

The PTS software will create the directory paths for the system cals if they do not
already exist. If not specified by the user, the CalSet_name will be set by the
PTS software to the string value “Default”. However, the user can force the
creation of a new calset by including the following line in the system calibration
Local Parameter Files:

string CalVersion "MyCalSet"

In order to force any payload measurement to use "MyCalSet" for the system
calibration directory, this line must also be included in the measurement's Local
Parameter File. In the absence of this line, the test would pick up system
calibration data from the “Default” calset directory.

Although the PTS software can be directed to create a new calset directory and
place system cal data files there automatically, the External Hardware
Configuration and Cal files will need to be added to the calset directory by the
user.
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This chapter describes the automated system functional test, including running
the individual tests, external connections, understanding test results, switch
controls, and switch paths for the Symtx N1891A-2 PTS.
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Performing the Automated System Functional Test

The system functional test (SFT) performs a basic check of the entire system,
including:

» Instrument self-tests to verify operation of each instrument in the system.

» Internal path tests to verify the interconnect cabling between the rack
instruments, PTE Unit, and the Remote Unit. In addition, the switch
functionality in the PTE Unit and Remote Unit is verified.

» External path tests to verify the interconnect cabling between the Remote
Unit, the TVAC Unit, and the external uplink and downlinks. In addition, the
switch functionality in the TVAC Unit is verified.

Purpose

Run the system functional test to verify the hardware is connected, configured,
and responding to program commands, and the necessary signal paths are
present and in good condition.

Conditions

Power on and ready for operation.

To help isolate problems with the system and to minimize operator interactions,
the SFT is composed of different test plans or sequences that verify the
operation of different instruments and pathways in the Symtx N1891A-2 PTS.

The system functional test can run from either the Measurement Computer or
the PTS server computer.

Table 9 System functional test sequences

Sequence name Description Test time
SFT_InstSelfTest Verifies operation of individual instruments under computer control. 10
minutes

SFT_IntPaths_ CKA Verifies operation of internal connections and switches for the 144150 3 minutes
PTE Unit and the 144140 Remote Unit from 1 GHz to 31.8 GHz.

SFT_IntPaths UHF Verifies operation of internal connections and switches for the 144150 2 minutes
PTE Unit and the 144140 Remote Unit from 100 MHz to 1 GHz.
SFT_ExtPaths Verifies external connections and uplink and downlink ports. 10
minutes
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Starting the System Functional Test

The system functional test (SFT) uses the Symtx N1891A-2 PTS software to
verify system functionality. It does not use a separate test executive.

To start the system functional test from the PTS server

» Start the Symtx N1891A-2 PTS GUI by double-clicking the N1891A icon.

The PTS GUI main window appears from which you start the system
functional tests.
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SFT Tests
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SFT Tests can be configured as a normal test using the PTS GUI.

Self test and measured paths can be changed in most instances. This is done by
changing the.msg file or by making changes in the test window before starting a
test.

SFT_InstSelfTests
» Performs self test on instruments to verify proper operation under computer
control.

« Default is for all instruments to be tested. Instruments can be excluded from a
test by changing “YES’ to “NO”.

Most instruments do not return a helpful error message to the PTS GUI.
Manually run the failing self test from the instrument front panel and read the
error message for clarity.

For more information see Table 10 on page 71. Unless otherwise specified, all
product model numbers are for products from Agilent Technologies.
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SFT IntPaths CKA

« Default is for all instruments to be tested. Instruments can be excluded from
test by changing “YES’ to “NO”.

» Measures internal path loss from 1 to 31.8 GHz with a CW signal.

» Default test frequency is 3 GHz. Limits are checked for this frequency only.
Frequency can be changed, but must be from 1 to 31.8 GHz.

* Averages are used by Spectrum Analyzer and VSA. Default is “1” average.
Averages can be changed if needed but more averages will slow down
measurements.

» Pause_on_failure is used when testing at 3 GHz and there is a failure.
Pauses program with instruments and paths set up for troubleshooting.
Default is “NO”. Change to “YES” if desired.

» Pause_before_Measure is used when testing at a frequency that doesn’t
check limits. Pauses program with instruments and paths set up for
troubleshooting. Default is “NO”. Change to “YES” if desired.

Instruments will be in Remote Mode when program pauses. Before manually
using instruments, change to Local Mode.

For more information see Table 11 on page 72. Unless otherwise specified, all
product model numbers are for products from Agilent Technologies.
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SFT IntPaths UHF

» Default is for all paths to be tested. Paths can be excluded from a test by
changing “YES” to “NQO".

» Measures the internal path loss from 100 MHz to 1 GHz with a CW signal.

» Default test frequency is 300 MHz. Limits are checked for this frequency only.
Frequency can be changed, but must be from 100 MHz to 1 GHz.

» Averages are used by spectrum analyzers and VSA. The default is “1”
average. Averages can be changed if needed but more averages slow down
measurements.

» Pause_on_Failure is used when testing at 300 MHz and there is a failure.
Pauses program with instruments and paths set up for troubleshooting.
Default is “NO”. Change to “YES” if desired.

» Pause_before_Measure is used when testing at a frequency that doesn’t
check limits. Pauses program with instruments and paths set up for
troubleshooting. Default is “NO”. Change to “YES” if desired.

Instruments will be in Remote mode when program pauses. Before manually
using instruments, change to Local mode.

For more information see Table 12 on page 77. Unless otherwise specified, all
product model numbers are for products from Agilent Technologies.

SFT_ExtPaths

* Measures the external path loss from 1 to 31.8 GHz with a CW signal.
Prompts will instruct the operator to connect cables to external ports.

Use exact cables as called out in prompts. If other cables are used, losses could
be different than expected.

» Default is for all paths to be tested. Paths can be excluded from a test by
changing “YES” to “NO”.

» Default test frequency is 3 GHz. Limits are checked for this frequency only.
Frequency can be changed must be from 1 to 31.8 GHz.

» Averages are used by spectrum analyzers and VSA. The default is “1”
average. Averages can be changed if needed but more averages will slow
down measurements.

» Pause_on_Failure is used when testing at 3 GHz and there is a failure.
Pauses program with instruments and paths set up for troubleshooting.
Default is “NO”. Change to “YES” if desired.
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» Pause_before_Measure is used when testing at a frequency that doesn’t
check limits. Pauses program with instruments and paths set up for
troubleshooting. Default is “NO”. Change to “YES” if desired.

Instruments will be in Remote mode when the program pauses. Before manually
using instruments, change to Local mode.

For more information see Table 13 on page 79. Unless otherwise specified, all
product model numbers are for products from Agilent Technologies.

Symtx N1891A-2 PTS User’s Guide 69



5 Running the System Functional Test

70 Symtx N1891A-2 PTS User’s Guide



Table 10SFT_InstSelfTests

SFT_InstSelfTests Purpose Computer Computer Output Cable Instrument Input Instrument

Purpose Card

RFSourcel Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E8267C
verify proper operation under Measuremen RFSourcel
computer control. t Computer

RFSource2 Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E8247C
verify proper operation under Measuremen RFSource2
computer control. t Computer

LOSourcel Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E8247C
verify proper operation under Measuremen LOSourcel
computer control. t Computer

LOSource2 Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E8247C
verify proper operation under Measuremen LOSource2
computer control. t Computer

SpectrumAnalyzer Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E4440A Spectrum
verify proper operation under Measuremen Analyzer
computer control. t Computer

VSA Perform Self Test on Instrumentto PTS E8491B FireWire PC IEEE-1394 E8491B VXI FireWire 89610A Vector
verify proper operation under Measuremen card cable slot O card Signal Analyzer
computer control. t Computer

CalPowerMeterl Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E4419B Cal
verify proper operation under Measuremen Power Meter
computer control. t Computer

ULPowerMeter Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E4419B UL/DL
verify proper operation under Measuremen Power Meter
computer control. t Computer

DLPowerMeter Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB E4419B UL/DL
verify proper operation under Measuremen Power Meter
computer control. t Computer

RFSwitchDriver Perform Self Test on Instrumentto PTS E2078A GPIB PC card GPIB GPIB 87130A Switch
verify proper operation under Measuremen Driver
computer control. t Computer

IFSwitchDriver Perform Self Test on Instrumentto  PTS E8491B FireWire PC IEEE-1394 E8491B VXI FireWire E1472A VXI
verify proper operation under Measuremen card cable slot O card Switch Cards
computer control. t Computer
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SFT_IntPaths_CKU Purpose Signal Cable 8760C 8760C 8760C 8760C 8760C 8760C Cable 8760C 8760C  8760C Cabl VXI VXI Cabl VXIE1472A VXI VXI Cabl
Source K69 Input K69 K69 K69 K69 K69 K68 Input K68 K68 e E1472A E1472A e Slot 6 Input  E1472A 1472A e Receive
Connecto Switch Switch Switch Switch Output Connecto Switch  Output Slot 6 Slot 6 #2 Slot 6 Slot 6 ;
r Positions Positions Positions Positions Connect r Setting Connect Input #1  First Second Outpu
uU/L U/L Cont. DJ/L D/L Cont. or s or Switch Switch t
UL_PwrMeter_Cal_Zero Calibrates E4419A w17 PM REF S8 C-2 N/A N/A N/A PMCHA W16 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E4419B
and Zeros UL/DL IN J8 S151-2 J4 UL/DL
Uplink Power Power Power
Sensor. Meter Meter
PWR REF
Out
DL_PwrMeter_Cal_Zero Calibrates E4419A w17 PM REF S152-3 N/A N/A N/A PMCHB W15 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E4419B
and Zeros UL/DL IN J8 J7 UL/DL
Downlink Power Power
Power Meter Meter
Sensor. PWR REF
Out
RFSourcel_DC5_Thru_t Measure E8267C w20 SRC1IN S22-3 S52-3 S14 3-4 S18 C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A E440A
0SA Path Loss RFSource J3 AT1 0dB S6 C-2 S16 3-4 S19 2-5 ouT Spectru
from RF 1 S32-3 S7C-6 S17C-1 S21C-6 J10 m
Sourcel to RF Out S42-3 Analyzer
Spectrum RF Input
Analyzer thru
DC5 and
Thru.
RFSourcel_DC5_AR2_t Measure E8267C w20 SRC1IN S22-3 S52-3 S14 3-4 S18 C-2 SPECAN W19 N/A N/A N/A N/A N/A N/A N/A  N/A N/A N/A E440A
0SA Path Loss RFSource J3 AT1 0dB S6 C-2 S16 3-4 S191-5 ouT Spectru
from RF 1 S32-3 S7 C-6 S17C-1 S21C-6 J10 m
Sourcel to RF Out S42-3 Analyzer
Spectrum RF Input
Analyzer thru
DC5 and
AR2.
RFSourcel DC5_AT5 to Measure E8267C W20 SRC1IN S22-3 S5 2-3 S14 3-4 S18 C-5 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A E440A
SA Path Loss RFSource J3 AT1 0dB S6 C-2 S16 3-4 S19 3-5 ouT Spectru
from RF 1 S32-3 S7 C-6 S17C-1 S21C-6 J10 m
Sourcel to RF Out S4 2-3 Analyzer
Spectrum RF Input
Analyzer thru
DC5 and
ATS.
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Table 11SFT_IntPaths CKU (continued)

Running the System Functional Test 5

SFT_IntPaths_CKU Purpose Signal Cable 8760C 8760C 8760C 8760C 8760C 8760C Cable 8760C 8760C  8760C Cabl VXI VXI Cabl VXIE1472A VXI VXI Cabl
Source K69 Input K69 K69 K69 K69 K69 K68 Input K68 K68 e E1472A  E1472A e Slot 6 Input E1472A 1472A e Receive
Connecto Switch Switch Switch Switch Output Connecto Switch  Output Slot 6 Slot 6 #2 Slot 6 Slot 6 ;
r Positions Positions Positions Positions Connect r Setting Connect Input #1  First Second Outpu
uU/L U/L Cont. DIL D/L Cont. or S or Switch Switch t

RFSrcl_ChkRef_toSA Measure E8267C W20 SRC1IN S22-3 S5 2-3 S143-4 S18 C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A E440A
frequency of RFSource J3 AT1 0dB S6 C-2 S16 3-4 S19 2-5 ouT Spectru
RF Source1 1 S32-3 S7C-6 S17C-1 S21C-6 J10 m
to Signal to RF Out S42-3 Analyzer
verify RF Input
common 10
MHz
Reference.

RFSrcl_ChkRef_toVSA  Measure E8267C W20 SRC1IN S22-3 S5 3-4 S10C-1 S21C-INT CH1RF W23 RF#1IN S134 IF#1 W31 COM50 COM50- W8l CHANNEL COMO0O0O- COM W75 89610A

CH1 frequency of RFSource J3 AT10dB S6C-2 S11 2-3 LOAD ouT J7 S22-3 OUT CHANNE 00 CHANNE 00 Vector
RF Source1 1 S32-3 S7 C-6 S12 J5 S334 J2 L 50 L 00 Signal
to Signal to RF Out S4 2-3 C-3S13 S4C-2 Analyzer
verify 2-5 S5C-2 Channel
common 10 S6 C-2 1
MHz
Reference.

RFSrc2_ChkRef _toVSA  Measure E8247C w18 SRC2IN Si1cC-1 S4 2-3 S14 3-4 S19 2-5 CH2RF W22 RF#2IN S134 IF#2 W32 CHANNE COM10- N/A N/A N/A COM W76 89610A

CH2 frequency of RF Ji S21-2 S5 2-3 S17 C-2 S21C-6 ouT J5 S22-3 OUT L 10 CHANNE 10 Vector
RF Source 2 Source 2 AT10dB S6C-2 S18 C-3 J11 S334 J3 L 10 Signal
to Signal to RF Out S32-3 S7C-6 S4C-2 Analyzer
verify S5C-2 Channel
common 10 S6 C-2 2
MHz
Reference.

RFSourcel Ul toSA Measure E8247C W20 SRC1IN Si1cC-1 S4 2-3 S14 3-4 S18 C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E440A
Path Loss RFSourc J3 S21-2 S5 2-3 S16 3-4 S19 2-5 ouT Spectru
from e2 AT10dB S6C-2 S17C-1 S21C-6 J10 m
RFSourcel RF Out S32-3 S7C-6 Analyzer
to Spectrum RF Input
Analyzer thru
Ul and DC5.
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Table 11SFT_IntPaths CKU (continued)

Running the System Functional Test 5

SFT_IntPaths_CKU Purpose Signal Cable 8760C 8760C 8760C 8760C 8760C 8760C Cable 8760C 8760C  8760C Cabl VXI VXI Cabl VXIE1472A VXI VXI Cabl
Source K69 Input K69 K69 K69 K69 K69 K68 Input K68 K68 e E1472A  E1472A e Slot 6 Input E1472A 1472A e Receive
Connecto Switch Switch Switch Switch Output Connecto Switch  Output Slot 6 Slot 6 #2 Slot 6 Slot 6 ;
r Positions Positions Positions Positions Connect r Setting Connect Input #1  First Second Outpu
uU/L U/L Cont. DIL D/L Cont. or S or Switch Switch t

RFSourcel_AT1_toSA Measure E8247C w20 SRC1IN S22-3 S52-3 S14 3-4 S18C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A N/A N/A N/A N/A  E440A
Path Loss RFSourc J3 AT111dB S6C-2 S16 3-4 S19 2-5 ouT Spectru
from e1lRF S32-3 S7C-6 S17 C-1 S21 C-6 J10 m
RFSourcel Out S4 2-3 Analyzer
to Spectrum RF Input
Analyzer thru
AT1@ 11dB
and DC5.

RFSourcel_ExtAmp_toS Measure E8247C w20 SRC1IN S22-3 S52-3 S14 3-4 S18C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A N/A N/A N/A N/A  E440A

A Path Loss RFSourc J3 AT10dB  S6C-2 S16 3-4 S192-5 ouT Spectru
from el S33-4 S7C-6 S17 C-1 S21 C-6 J10 m
RFSourcel S4 2-3 Analyzer
to Spectrum RF Input
Analyzer thru
External Amp
path and
DCS5.

RFSourcel_AT2_toSA Measure E8247C W20 SRC1IN S22-3 S5 3-4 S143-4 S18 C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E440A
Path Loss RFSourc J3 AT10dB  S6C-2 S16 3-4 S192-5 ouT Spectru
from el S32-3 S7C-6 S17C-1 S21 C-6 J10 m
RFSourcel S4 2-3 Analyzer
to Spectrum RF Input
Analyzer thru
AT2 and
DCs5.

RFSourcel_AT4 toSA Measure E8247C W20 SRC1IN S22-3 S5 2-3 S10C-2 S141-4 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E440A
Path Loss RFSource J3 AT1 0dB S6 C-2 S11 2-3 S16 1-4 ouT Spectru
from 2 S32-3 S7C-6 S12 C-3 S21C-6 J10 m
RFSourcel RF Out S4 2-3 S132-3 Analyzer
to Spectrum RF Input
Analyzer thru
ATA4.

RFSource2_U1_toSA Measure E8247C w18 SRC2IN S1C-1 S4 2-3 S143-4 S18 C-3 SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A  N/A N/A N/A N/A  E440A
Path Loss RFSource J1 S21-2 S5 2-3 S16 3-4 S19 2-5 ouT Spectru
from 2 AT10dB S6C-2 S21C-36 S21C-6 J10 m
RFSource2 RF Out S32-3 S7C-6 Analyzer
to Spectrum RF Input
Analyzer thru
Ul and DC5
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Running the System Functional Test 5

Table 11SFT_IntPaths CKU (continued)

SFT_IntPaths_CKU Purpose Signal Cable 8760C 8760C 8760C 8760C 8760C 8760C Cable 8760C 8760C  8760C Cabl VXI VXI Cabl VXIE1472A VXI VXI Cabl
Source K69 Input K69 K69 K69 K69 K69 K68 Input K68 K68 e E1472A  E1472A e Slot 6 Input E1472A 1472A e Receive
Connecto Switch Switch Switch Switch Output Connecto Switch  Output Slot 6 Slot 6 #2 Slot 6 Slot 6 ;
r Positions Positions Positions Positions Connect r Setting Connect Input #1  First Second Outpu
uU/L U/L Cont. DIL D/L Cont. or S or Switch Switch t

RFSourcel_DC1_Thru_t Measure E8267C W20 SRC1IN S22-3 S534 S11 2-3 S21C- SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A N/A N/A N/A N/A  E440A

0SA Path Loss RFSource J3 AT1 0dB S6 C-2 S12 C-3 INT_ ouT Spectru
from 1 S32-3 S7C-6 S132-5 LOAD J10 m
RFSourcel RF Out S42-3 S10C-2 S16 1-4 Analyzer
to Spectrum RF Input
Analyzer thru
DC1 coupled
am and thru.

RFSourcel_DC1_AR1_t Measure E8267C w20 SRC1IN S22-3 S534 S11 2-3 S21C- SPECAN W19 N/A N/A N/A N/A  N/A N/A N/A N/A N/A N/A N/A  E440A

0SA Path Loss RFSource J3 AT1 0dB S6 C-2 S12 C-2 INT_ ouT Spectru
from 1 S32-3 S7C-6 S132-5 LOAD J10 m
RFSourcel RF Out S42-3 S10 C-2 S16 1-4 Analyzer
to Spectrum RF Input
Analyzer thru
DC1 coupled
arm and
ARL.

RFSourcel_DC1 _AT3_to Measure E8267C W20 SRC1IN S22-3 S5 3-4 S11 2-3 S21C- SPECAN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E440A

SA Path Loss RFSource J3 AT1 0dB S6 C-2 S12 C-5 INT_ ouT Spectru
from 1 S32-3 S7C-6 S133-5 LOAD J10 m
RFSourcel RF Out S4 2-3 S16 1-4 Analyzer
to Spectrum RF Input
Analyzer thru
DC1 coupled
am and AT3.

RFSrcl_DC1_DC3_toP  Measure E8267C W20 SRC1IN S22-3 S6 C-2 S11 2-3 S21C- PMCHA W16 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4419B

MCHA Path Loss RFSource J3 AT10dB S7C-6 S12 C-3 INT_ J4 UL/DL
from 1 S32-3 S8 C-1 S132-5 LOAD Power
RFSourcel RF Out S4 2-3 S9C-1 S16 1-4 Meter
to Power S534 S10C-2
Meter CH A
thru DC1 and
DC3 coupled
ams.

RFSourcel_toPMCHB Measure E8267C W20 SRC1IN S22-3 S52-3 S14 3-4 N/A PMCHB W15 N/A N/A N/A N/A  N/A N/A N/A N/A N/A N/A N/A  E4419B
Path Loss RFSource J3 AT10dB S6C-2 S153-4 J7 UL/DL
from 1 S32-3 S7C-6 S20 2-3 Power
RFSourcel RF Out S42-3 S21 C-6 Meter
to Power
Meter CH B
thru DC5.
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Table 11SFT_IntPaths CKU (continued)

Running the System Functional Test 5

SFT_IntPaths_CKU Purpose Signal Cable 8760C 8760C 8760C 8760C 8760C 8760C Cable 8760C 8760C  8760C Cabl VXI VXI Cabl VXIE1472A VXI VXI Cabl
Source K69 Input K69 K69 K69 K69 K69 K68 Input K68 K68 e E1472A  E1472A e Slot 6 Input E1472A 1472A e Receive
Connecto Switch Switch Switch Switch Output Connecto Switch  Output Slot 6 Slot 6 #2 Slot 6 Slot 6 ;
r Positions Positions Positions Positions Connect r Setting Connect Input #1  First Second Outpu
uU/L U/L Cont. DJ/L D/L Cont. or s or Switch Switch t
RFSourcel DC1_ToVSA Measure E8267C W20 SRC1IN S22-3 S5 34 S10C-1 S21C- CH1RF W23 RF#1IN S134 IF#1 W31 COM50 COM50- W81 CHANNEL COMO0O0- COM W75 89610A
CH1 Path Loss RFSource J3 AT1 0dB S6 C-2 S11 2-3 INT_ ouT J7 S22-3 OUT CHANNE 00 CHANNE 00 Vector
from 1 S32-3 S7C-6 S12 C-3 LOAD J5 S334  J2 L 50 L 00 Signal
RFSourcel RF Out S42-3 S13 2-5 S4 C-2 Analyzer
to VSA CH1 S5C-2 Channel
thru DC1 and S6 C-2 1
Downconvert
er CH1lin
normal mode.
RFSourcel DC5_ToVSA Measure E8267C W20 SRC1IN S22-3 S5 2-3 S14 3-4 S19 2-5 CH2RF W22 RF#2IN S134 IF#2 W32 CHANNE COM10- N/A N/A N/A COM W76 89610A
CH2 Path Loss RFSource J3 AT1 0dB S6 C-2 S17 C-2 S21C-6 ouT J5 S22-3 OUT L CHANNE 10 Vector
from 1 S32-3 S7 C-6 S18 C-3 Jia S33-4 33 10 L 10 Signal
RFSourcel RF Out S4 2-3 S4 C-2 Analyzer
to VSA CH2 S5C-2 Channel
thru DC5 and S6 C-2 2
Downconvert
er CH2 in
normal mode.
RFSourcel_Track Measure E8267C W20 SRC1IN S22-3 S53-4 S10C-1 S21C- CH1RF W23 RF#LIN S134 IF#1 w3l COM50 COM50- W81 CHANNEL COMO0O0O- COM W75 89610A
ToVSACH1 Path Loss RFSource J3 AT1 0dB S6 C-2 S11 2-3 INT_ ouT J7 S21-2 OUT CHANNE 00 CHANNE 10 Vector
from 1 S32-3 S7C-6 S12 C-3 LOAD J5 S334 J2 L 50 L 00 Signal
RFSourcel RF Out S42-3 S132-5 S4C-2 Analyzer
toVSACH1 S5C-2 Channel
thru DC1 and S6 C-2 1
Downconvert
er CHlin
tracking
mode.
RFSrcl_Eventl ToVSA  Measure E8267C W20 SRC1IN S22-3 S5 34 S10C-1 S21C- CH1RF W23 RF#1IN S134 IF#1 W31 COM50 COM50- W81 CHANNEL COMO0O0- COM W75 89610A
CH1 Path Loss RFSource J3 AT1 0dB S6 C-2 S11 2-3 INT ouT J7 S22-3 OUT CHANNE 00 CHANNE 00 Vector
RF Path from 1 S32-3 S7 C-6 S12 C-3 _LOAD J5 S334  J2 L 50 L 00 Signal
RFSourcel RF Out S42-3 S13 2-5 S4 C-2 Analyzer
to VSACH 1 S5C-2 Channel
thru DC1 and S6 C-2 1
Downconvert
erCH1in
normal mode
using Eventl
as VSA Ext
Trigger.
RFSrcl_Eventl_ToVSA E8267C w29 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A COM30 COM30- W79 CHANNEL COM20- COM W29 89610A
CH1 RFSource CHANNE 20 CHANNE 20 Vector
Eventl Path 1 L 30 L 20 Signal
Event Analyzer
Ext
Trigger
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Table 12SFT_IntPaths_UHF

Running the System Functional Test 5

SFT_IntPaths_ UHF Purpose Signal Cabl 8760C 8760C 8760C 8760C K69 8760C 8760C K69 Cable 8760C 8760C 8760C Cable VXI VXI Cable VXI VXI VXI Cabl Receiver
Source e K69 Input K69 K69 Switch K69 Output K68 K68 K68 E1472 E1472A E1472A E1472A  E1472 e
Connecto Switch  Switch Positions Switch Connector Input Switch Output A Slot Slot6 Slot 6 Slot 6 A Slot
r Positio  Positions D/L Positions Connect Settings  Connecto 6 First Input Second 6
ns U/L Cont. D/L Cont. or r Input  Switch #2 Switch Outpu
u/L #1 t
RFSourcel_DC6_Thru_t Measure Path E8267C W20 SRC1IN S22-3 S52-3 S14 3-4 S19 1-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
0SA Loss from RFSourc J3 AT10dB S6C-2 S16 3-4 S201-2 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S17 C-1 S21 C-6 J10 Analyzer
Spectrum RF Out S4 3-4 S18 C-3 RF Input
Analyzer thru
DC6 and
Thru.
RFSourcel_DC6_AR2_t Measure Path E8267C W20 SRC1IN S22-3 S52-3 S14 3-4 S19 2-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
0SA Loss from RFSourc J3 AT10dB S6C-2 S16 3-4 S201-2 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S17 C-1 S21 C-6 J10 Analyzer
Spectrum RF Out S4 3-4 S18 C-2 RF Input
Analyzer thru
DC6 and AR2.
RFSourcel _DC6_AT5_to Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 S14 3-4 S19 3-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
SA Loss from RFSourc J3 AT10dB S6 C-2 S16 3-4 S20 1-2 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S17C-1 S21C-6 J10 Analyzer
Spectrum RF Out S4 3-4 S18 C-5 RF Input
Analyzer thru
DC6 and AT5.
RFSourcel AT1 toSA Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 S14 3-4 S191-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
Loss from RFSourc J3 AT1 S6 C-2 S16 3-4 S201-2 ouT Spectrum
RFSourcelto el 11dB S7C-6 S17C-1 S21C-6 J10 Analyzer
Spectrum RF Out S32-3 S18 C-3 RF Input
Analyzer thru S4 .34
AT1@ 11dB
and DC6.
RFSourcel ExtAmp_toS Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S14 3-4 S191-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
A Loss from RFSourc J3 AT10dB S6 C-2 S16 3-4 S20 1-2 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S17C-1 S21C-6 J10 Analyzer
Spectrum S4 3-4 S18 C-3 RF Input
Analyzer thru
External Amp
Path and
DCS6.
RFSourcel AT2_toSA Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S14 3-4 S191-6 SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
Loss from RFSourc J3 AT10dB S6 C-2 S16 3-4 S201-2 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S17C-1 S21C-6 J10 Analyzer
Spectrum S4 3-4 S18 C-3 RF Input
Analyzer thru
AT2 and DC6.
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Table 12SFT_IntPaths_ UHF (continued)

Running the System Functional Test 5

SFT_IntPaths_UHF Purpose Signal Cabl 8760C 8760C 8760C 8760C K69 8760C 8760C K69 Cable 8760C 8760C 8760C Cable VXI VXI Cable VXI VXI VXI Cabl Receiver
Source e K69 Input K69 K69 Switch K69 Output K68 K68 K68 E1472 E1472A E1472A E1472A  E1472 e
Connecto Switch  Switch Positions Switch Connector Input Switch Output A Slot Slot6 Slot 6 Slot 6 A Slot
r Positio  Positions D/L Positions Connect Settings  Connecto 6 First Input Second 6
ns U/L Cont. D/L Cont. or r Input  Switch #2 Switch Outpu
U/L #1 t
RFSourcel_AT4_toSA Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 S11 3-4 S14 1-4 SPEC AN w19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
Loss from RFSourc J3 AT10dB S6C-2 S12 C-3 S16 1-4 ouT Spectrum
RFSourcelto el S32-3 S7C-6 S132-4 S21C-6 J10 Analyzer
Spectrum RF Out S4 3-4 S10 C-2 RF Input
Analyzer thru
ATA4,
RFSourcel DC2_Thru_t Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S11 3-4 S21C- SPEC AN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
0SA Loss from RFSourc J3 AT10dB S6 C-2 S12 C-2 INT_ ouT Spectrum
RFSourcelto el S32-3 S7C-6 S131-5 LOAD J10 Analyzer
Spectrum RF Out S43-4 S10C-2 S16 1-4 RF Input
Analyzer thru
DC2 coupled
arm and thru.
RFSourcel DC2_AR1_t Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S11 3-4 S21C- SPEC AN w19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
0SA Loss from RFSourc J3 AT10dB S6 C-2 S12C-5 INT_ ouT Spectrum
RFSourcelto el S32-3 S7C-6 S133-5 LOAD J10 Analyzer
Spectrum RF Out S4 3-4 S10 C-2 16 1-4 RF Input
Analyzer thru
DC2 coupled
am and AR1.
RFSourcel DC2_AT3 to Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S11 3-4 S21C- SPEC AN w19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4440A
SA Loss from RFSourc J3 AT10dB S6 C-2 S12 C-3 INT_LOA OUT Spectrum
RFSourcelto el S32-3 S7C-6 S133-5 D J10 Analyzer
Spectrum RF Out S4 3-4 S16 1-4 RF Input
Analyzer thru
DC2 coupled
arm and AT3.
RFSrcl_DC2_DC4_toP  Measure Path E8267C W20 SRC1IN S22-3 S6 C-2 S11 3-4 S21C- PMCHA W16 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4419B
MCHA Loss from RFSourc J3 AT10dB S7C-6 S12C-3 INT J4 UL/DL
RFSourcelto el S32-3 S8 C-1 S132-5 _LOAD Power
Power Meter ~ RF Out S43-4 S9C-1 S16 1-4 Meter
CH A thru S53-4
DC2 coupled
am and AT3.
RFSourcel_toPMCHB Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 S14 3-4 N/A PM CHB w15 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A  E4419B
Loss from RFSourc J3 AT10dB S6C-2 S15 3-4 J7 uL/DL
RFSourcelto el S32-3 S7C-6 S20 2-3 Power
Power Meter ~ RF Out S43-4 S21C-6 Meter
CH B thru
DCE6.
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Table 12SFT_IntPaths_ UHF (continued)

Running the System Functional Test 5

SFT_IntPaths_UHF Purpose Signal Cabl 8760C 8760C 8760C 8760C K69 8760C 8760C K69 Cable 8760C 8760C 8760C Cable VXI VXI Cable VXI VXI VXI Cabl Receiver
Source e K69 Input K69 K69 Switch K69 Output K68 K68 K68 E1472 E1472A E1472A E1472A E1472 e
Connecto Switch  Switch Positions Switch Connector Input Switch Output A Slot Slot6 Slot 6 Slot 6 A Slot
r Positio  Positions D/L Positions Connect Settings  Connecto 6 First Input Second 6
ns U/L Cont. D/L Cont. or r Input  Switch #2 Switch Outpu
U/L #1 t
RFSourcel_DC2_toVSA Measure Path E8267C W20 SRC1IN S22-3 S5 34 S10C-1 S21C- CH1RF W23 RF#1IN S12-3 IF#1 OUT W31 COM COM50- W81 CHANN COMO00 COM W75 89610A
CH1 Loss from RFSourc J3 AT10dB S6 C-2 S11 3-4 INT LOAD OUT J7 S2 3-4 J2 50 CHANN EL CHANNE 00 Vector
RFSourcelto el S32-3 S7C-6 S12 C-3 J5 S32-3 EL 50 00 L 00 Signal
VSACH1 RF Out S4 3-4 S13 2-5 S4C-1 Analyzer
thru DC2 and S5C-1 Channel 1
Downconverte S6 C-1
r CH1in Low
Band mode.
RFSourcel_DC6_toVSA Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 S14 3-4 S19 2-6 CH 2 RF w22 RF#2IN S12-3 IF#2 OUT W32 CHAN COM10- N/A N/A N/A COM W76 89610A
CH2 Loss from RFSourc J3 AT10dB S6 C-2 S15 3-4 S201-2 ouT J5 S2 3-4 J3 NEL CHANN 10 Vector
RFSourcelto el S32-3 S7C-6 S17 C-2 S21 C-6 J11 S32-3 10 EL 10 Signal
VSA CH 2 RF Out S4 34 S18 C-3 S4C-1 Analyzer
thru DC6 and S5C-1 Channel 2
Downconverte S6 C-1
r CH 2 in Low
Band mode.
Table 13SFT_ExtPaths
SFT_ExtPaths Purpose Signal  Cabl 8760C 8760C 8760C 8760C 8760C K69 8760C 8760C K69 8760C Cabl 8760C 8760C 8760C VXI VXI Cabl VXI VXI VXI Cabl Receiver
Source e K69 K69 K69 K69 Input K69 Switch K69 e K68 Input K68 K68 Cabl E1472A E1472A e E1472A E1472A E1472 e
Input Switch Switch Output Connector Switch  Positions  Output Connecto Switch Output e Slot 6 Slot 6 Slot 6 Slot 6 A Slot
Connect Position Position Connector Positio D/L Cont.  Connect r Setting Connect Input First Input Second 6
or S S ns or S or #1 Switch #2 Switch Outpu
u/L u/L DI/L. t
Cont.
RFSourcel_ULl_DLl_IOSA1 Measure Path E8267C W20 SRC1IN S22-3 S52-3 UPLINKS DOWNLIN  S143-4 S18C-3 SPECAN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A E4440A
Loss from RFSour J3 AT10dB S6C-2 1 KS S163-4 S192-5 ouT Spectrum
RFSourcel to cel S32-3 S7C-1 1 S17C-1 S21C-1 J10 Analyzer
UL Port thru RF Out S42-3 RF Input
SFT cable DL
Port then to
Spectrum
Analyzer.
RFSourcel_ULZ_DLZ_tOSA1 Measure Path E8267C W20 SRC1IN S22-3 S52-3 UPLINKS DOWNLIN S143-4 S18C-3 SPECAN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A E4440A
Loss from RFSour J3 AT10dB S6C-2 2 KS S16 3-4 S192-5 ouT Spectrum
RFSourcel to cel S32-3 S7C-2 2 S17C-1 S21C-2 J10 Analyzer
UL Port thru RF Out S4 2-3 RF Input
SFT cable DL
Port then to
Spectrum
Analyzer.
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SFT_ExtPaths Purpose Signal  Cabl 8760C 8760C 8760C 8760C 8760C K69 8760C 8760C K69 8760C Cabl 8760C 8760C 8760C VXI VXI Cabl  VXI VXI VXI Cabl Receiver
Source e K69 K69 K69 K69 Input K69 Switch K69 e K68 Input K68 K68 Cabl E1472A E1472A e E1472A E1472A E1472 e
Input Switch Switch Output Connector Switch  Positions  Output Connecto Switch Output e Slot 6 Slot 6 Slot 6 Slot 6 A Slot
Connect Position Position Connector Positio D/L Cont.  Connect r Setting Connect Input First Input Second 6
or S S ns or S or #1 Switch #2 Switch Outpu
u/iL u/L DI/L. t
Cont.
RFSourcel_UL3_DL3_toSA?! Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 UPLINKS DOWNLIN S143-4 S18C-3 SPECAN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A E4440A
Loss from RFSour J3 AT10dB S6C-2 3 KS S163-4 S192-5 ouT Spectrum
RFSourcel to cel S32-3 S7C-3 3 S17C-1 S21C-3 J10 Analyzer
UL Port thru RF Out S42-3 RF Input
SFT cable DL
Port then to
Spectrum
Analyzer.
RFSourcel_UL4_DL4_toSA! Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 UPLINKS DOWNLIN S143-4 S18C-3 SPECAN W19 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A E4440A
Loss from RFSour J3 AT10dB S6C-2 4 KS S163-4 S192-5 ouT Spectrum
RFSourcel to cel S32-3 S7C-4 4 S17C-1 S21C-4 J10 Analyzer
UL Port thru RF Out S4 2-3 RF Input
SFT cable DL
Port then to
Spectrum
Analyzer.
RFSourcel_UL5_DL5_toSA! Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 UPLINKS DOWNLIN S143-4 S18C-3 SPECAN W23 RF#1IN S22-3 |IF#1 W31 COM50 COM 50- w81 CHANNE COMO00- COM W75 89610A
Loss from RFSour J3 AT10dB S6C-2 5 KS S163-4 S192-5 ouT J7 S33-4 OuUT CHANNEL L CHANNE 00 Vector
RFSourcel to cel S32-3 S7C-5 5 S17C-1 S21C-5 J10 S4C-2 J2 50 00 L 00 Signal
UL Port thru RF Out S42-3 S5C-2 Analyzer
SFT cable DL S6 C-2 Channel
Port then to 1
Spectrum
Analyzer.
RFSourcel_UL1_DLCH1_toSA Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 UPLINKS DOWNLIN S10C-2 S141-4 SPECAN W22 RF#2IN S22-3 [IF#2 W32 CHANNE COM 10- N/A N/A N/A COM W76 89610A
Loss from RFSour J3 AT10dB S6C-2 1 KS S112-3 S161-4 ouT J5 S33-4 OUT L CHANNEL 10 Vector
RFSourcel to cel S32-3 S7C-1 CH1 S12C-3 S18C-3 J10 S4C-2 J3 10 10 Signal
UL Port thru RF Out S42-3 S132-4 S192-5 S5C-2 Analyzer
SFT cable DL S6 C-2 Channel
Port then to 2
Spectrum
Analyzer.
RFSrcl1_Evntl_InOut_ VSACH Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 CH1RF CH1RF S10C-1 S21C CH1RF W23 RF#LIN S22-3 |IF#1 W31 COM50 COM50 w81 CHANNE COMO0O0O COM W75 89610A
1 RFPath Loss from RFSour J3 AT10dB S6C-2 OUT J5 OUT J5 S112-3 INT_LOAD OUT J7 S33-4 OUT CHANNEL L CHANNE 00 Vector
RFSourcel to cel S32-3 S7C-6 S12C-3 J5 S4C-2 J2 50 00 L 00 Signal
VSA CH1 thru RF Out S4.2-3 S132-5 S5 C-2 Analyzer
DC1 and S6 C-2 Channel
Downconverter 1
CH1 in normal
mode using
Eventl as VSA
Ext Trigger.
RFSrc1_Evntl_InOut_VSACH E8267C W29 N/A N/A N/A N/A N/A N/A N/A N/A N/A  N/A N/A N/A N/A COM30 COM 30- W79 CHANNE COM20- COM W29 89610A
1 EventPath RFSour CHANNEL L CHANNE 20 Vector
cel 30 20 L 20 Signal
Eventl Analyzer
Ext
Trigger
Symtx N1891A-2 PTS User’s Guide 80
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SFT_ExtPaths Purpose Signal  Cabl 8760C 8760C 8760C 8760C 8760C K69 8760C 8760C K69 8760C Cabl 8760C 8760C 8760C VXI VXI Cabl  VXI VXI VXI Cabl Receiver
Source e K69 K69 K69 K69 Input K69 Switch K69 e K68 Input K68 K68 Cabl E1472A E1472A e E1472A E1472A E1472 e
Input Switch Switch Output Connector Switch  Positions  Output Connecto Switch Output e Slot 6 Slot 6 Slot 6 Slot 6 A Slot
Connect Position Position Connector Positio D/L Cont.  Connect r Setting Connect Input First Input Second 6
or S S ns or S or #1 Switch #2 Switch Outpu
u/L u/L DI/L. t
Cont.
Cal Pwrmeter_1_Cal_Zero Calibrates and  E4419A W17 PMREF S8 CO02 N/A PM CH A PM CH A N/A N/A PMCHA W16 N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A N/A E4419B
Zeros Uplink UL/DL IN S151-2 Ja Ja Ja UL/DL
Power Sensor Power J8 Power
Meter Meter
PWR
REF
Out
RFSrcl_DetVid_toVSA_CH1 Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 CH1RF CH1RF S10C-1 S21-C CH1RF W23 RF#1IN S134 IF10UT W31 COM50 COM 50- W81 CHANNE COMO00- COM W75 89610A
Loss from RF J3 AT10dB S6C-2 ouT ouT S112-3 INTLOAD OUT J7 S22-3 J2 CHANNEL L CHANNE 00 Vector
RFSourcel to Source S32-3 S7C-6 J5 J5 S12 C-3 J5 S334 50 00 L 00 Signal
VSA CHL1 thru 1 S42-3 S132-5 S4 C-2 Analyzer
DC1 and RF Out S5C-2 Channel
Downconverter S6 C-2 1
CH1 in normal
mode.
RFSrcl_DetVid_toVSA_CH2 Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 CH 2 RF CH 2 RF S143-4 S192-5 CH2RF W22 RF#2IN S134 [IF20UT W32 CHANNE COM 10- N/A N/A N/A COM W76 89610A
Loss from RF J3 AT10dB S6C-2 ouT ouT S17C-2 S21C-6 ouT J5 S22-3 J3 L CHANNEL 10 Vector
RFSourcel to Source S32-3 S7C-6 J1l J1l S18C-3 J1ul S33-4 10 10 Signal
VSA CH2 thru 1 S4 2-3 S4 C-2 Analyzer
DC5 and RF Out S5 C-2 Channel
Downconverter S6 C-2 2
CH2 in normal
mode.
RFSrcl_CH1_if InOut_toVSA  Measure Path E8267C W20 SRC1IN S22-3 S5 2-3 CH2RF CH 2 RF S143-4 S192-5 CH2RF W22 RF#2IN S134 [IF20UT W32 CHANNE COM 10- N/A N/A N/A COM W76 89610A
Loss from RF J3 AT10dB S6C-2 ouT ouT S17C-2 S21C-6 ouT J5 S22-3 J3 L CHANNEL 10 Vector
RFSourcel to Source S32-3 S7C-6 J11 J11 S18 C-3 J11 S334 10 10 Signal
VSA CH2 thru 1 S42-3 S4 C-2 Analyzer
DCS5 and RF Out S5C-2 Channel
Downconverter S6 C-2 2
CH2 in normal
mode.
Ref_Out_toExtSrc_in_toSA Measure Path E8267C W20 SRC1IN S22-3 S5 3-4 CH1RF CH1RF S10C-1 S21C CH1RF W23 RF#1IN S134 IF10OUT W31 COM50 COM W81 CHANNE COMO00- COM W75 89610A
Loss from RF J3 AT10dB S6C-2 ouT ouT S112-3 INT_LOAD OUT J7 S22-3 J2 50-CHANN L CHANNE 00 Vector
RFSourcel to Source S32-3 S7C-6 J5 J5 S12C-3 J5 S33-4 EL 50 00 L 00 Signal
VSA CHL1 thru 1 S4 2-3 S132-5 S4 C-2 Analyzer
DC1 and RF Out S5C-2 Channel
Downconverter S6 C-2 1
CH1 in tracking
mode.
1SFT cable part number 84000-80011
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This chapter describes how to use the Symtx N1891A-2 PTS graphical user
interface (PTS GUI) to set up and define test articles and phases.
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6 Creating Test Articles and Phases

Adding and Copying a Test Article

84

Each test article you add creates an element in the PTS GUI. A test article can
contain many phases. To add a phase, see “ Adding and Copying Phases” on
page 86. Under each phase, add testIDs (tests). See Chapter 7, “Adding and
Defining Tests and Calibrations_for information about creating and defining tests.

Test articles cannot be deleted or renamed from the PTS GUI.

File naming constraints

The machine, share, test article, phase, test, and support file names have an
aggregate limit of 76 characters.! To stay within this limit, follow the
recommended constraints in Table 14. You may develop your own standards for
file name lengths, as long as the aggregate does not exceed 76 characters.

File names may contain upper and lower case characters, numerals, and
underbars (), hyphens (-) and spaces. They may not contain other special
characters, such as:

LIF&@#S WM+ =\2<>~"~[1{}()

Table 14File naming constraints

Element name File name Example
Length
Machine 6 PC1218 [fixed when networking is set up]
Share 6 N1891A [fixed]
Test Article 8 TestSAT
Phase 8 Ambient
Test 20 Freq response linear
File 28 FRInBand_Linear.msg

To add a new test article

After you add a test article through the PTS GUI, you may populate it with files
and folders from the \ATP folder. For your convenience, these files contain
examples of data you must add to define your test article, but with values that do

1 This is a limitation based on the maximum number of characters that can be displayed or printed
in the header portion of the data presentation for each test ID. 76 characters is a
recommendation and is not a fixed limit.
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not match your individual requirements. You must edit this data through the PTS
GUI before you can successfully run any tests. You may also populate it with
files and folders from any other test article.

To add a new test article

Step Action

Notes

a Double-click N1891A PTS on the
desktop to open the PTS GUI.

1 Openthe PTS GUI
and expand the Test
Library.

b Click the plus (+) symbol to expand Test
Library.

¢ Right-click the Test Library and select
New Test Article.

e Enter a name for the new test article
and click OK.

Create the test
article.

To copy a test article

¢ This action displays the list of test
articles.

* The Name dialog box appears.

* You may need to reexpand the Test
Library before the new test article
appears.

You may use an existing test article as a model for a new test article. After you
create the new test article, you may populate it with files and folders from
another test article. Care must be taken to assure that the other test article used
the latest measurement template in its development. You may need to edit this
data from the PTS GUI before you can successfully run any test.

To add a new test article by copying an existing test article

Step Action

Notes

Select the test article directory that
you wish to copy.

1 Use Windows Explorer
to copy existing test
article directory.

a

Press Citrl-C to copy.

In the same directory, press Ctrl-V to
paste.
Rename the newly-copied directory.

2 Confirm that the new
test article has been
created.

Open the PTS GUI and expand the
test library.

Expand and compare the new test
article and the source test article.

Symtx N1891A-2 PTS User’s Guide

* You may need to select View >
Refresh before you can see the
new test article folder in Windows
NT Explorer.

* The new test article appears in the
list.
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Adding and Copying Phases

As with a test article, each phase added creates an icon in the PTS GUI. Under
each phase, add the testIDs (tests). You may also use an existing phase as a
model for a new phase. See Chapter 7, “Adding and Defining Tests and
Calibrations for information about creating and defining tests.

Phases cannot be renamed from the PTS GUI.

File naming constraints

The machine, share, test article, phase, test, and support file names have an
aggregate limit of 76 characters.! See “ File naming constraints” on page 84 for

more information.

To add a new test phase

After you add a test phase through the PTS GUI, you may populate it with files
and folders from another test phase. Care must be taken to assure that the other
test phase used the latest measurements in its development. You may need to
edit this data through the PTS GUI before you can successfully run any tests.

Phase names must not contain spaces.

To add a new phase

Step Action Notes
1 Open the PTS GUI and a Double-click N1891A EXX PTS on the
expand the Test Library. desktop to open the PTS GUI.
b Click the plus (+) symbol to expand Test * This action displays
Library. the list of test articles.
¢ Right-click the name of the test article to * The Name dialog box
which you want to add the phase, and select appears.
New Phase.
2 Create the phase. ¢ Enter a name for the new phase and click * The new phase
OK. appears in the Test

Library.

1 This is a limitation based on the maximum number of characters that can be displayed or printed
in the header portion of the data presentation for each test ID. 76 characters is a

recommendation and is not a fixed limit.
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To copy a phase

You may use an existing phase as a model for a new phase.

To add a new phase by copying an existing phase

6

Step Action Notes
1 Use Windows NT Explorerto a Select the phase that you wish to copy. * You may need to
copy the existing phase. select View >

Refresh before you
can see the new
phase folder.

b Press Ctrl-C to copy.

¢ In the same directory, press Ctrl-V to paste.
d Rename the newly-copied phase.

2 Confirm that the new phase a Open the PTS GUI and expand the test * The new phase
has been created. library. appears in the list.

b Expand and compare the new phase and the
source phase.

Symtx N1891A-2 PTS User’s Guide
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Using Local Variable Lookup

Local variable lookup (LVL) is an optional (developer-defined) process that
configures tests to use power levels determined by gain transfer measurements.

The gain transfer test creates the local variable lookup file that contains the input
reference power for the desired operating point. Therefore, the input reference
power specified for the gain transfer test must be reasonable approximations of
the actual operating point. They cannot be the default value (—999). For all other
tests, setting these values to —999 forces the tests to use local variable lookup
as defined by your gain transfer test.

To set up the local variable lookup

To set up the local variable lookup

Step Notes

1 Create a list of parameters in the * List the parameters from the
CustVarsSingle.txt file in the \ program schedule message (PSM)
N1891AEXX\etc\conflarticleneme\ for which you want to store power
phasename\ folder. For example: references.
UUTCFG * For single-tone and two-tone
InputPort measurements, edit
OutputPort CustVarsSingle.txt. This file must

contain at least one parameter.

* Valid parameters are those common
to the program schedule message
for each measurement using this
local variable lookup file.

2 Edit the PSMs (.msg files) for gain transfer
measurements to insert target values
appropriate for the DUT in the variable
InputReferencePower. For example:
double InputReferencePower -60

Target values exceeding device specifications can
damage your system.

3 Run the gain transfer test. * The system creates/updates the
LocalVarindex.txt file, which consists
of pointers to the local variable (LV)
files.
* The location of this index file is
specific to a article and phase.
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To perform local variable lookup

To perform local variable lookup

Step Notes

1 Inthe PSMs (.msg files) of the testIDs for * The files are named
which you want to use LVL, set the values for testID_filename.msg where
InputReferencePower to —999. For example: filename is defined appropriately.
double InputReferencePower -999 * If you set these parameters to
double CWTest Frequency value absolute values (other than
double ChannellOFrequency value —999), the system uses those

values and does not perform LVL.

* [f a gain transfer test has been
run for this combination, the
LocalVarindex.txt file contains a
corresponding entry. The index
file also contains the name of the
file holding all the gain transfer
data. The system retrieves the
data and lets the measurement
continue.

* If a gain transfer has not been
run, the system prompts the
operator to perform one.

2 Confirm that all parameters listed in
CustVarsSingle.txt are in the PSM for the
testlD, and have variable settings identical to
those used in the gain transfer test
configured for the spacecraft and
environment.

3 When you run one of these testIDs, the
system reads the CustVarsSingle.txt file and
compares it to the PSM for the current testID.

4 After the system has identified each
parameter and its value (in the current
measurement), it checks the
LocalVarlndex.txt file to determine if this
exact combination of parameters and values
has current gain transfer values.
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This chapter defines test-related support files; adding, editing, viewing, and
printing tests and support files; defining test IDs using support files; and
understanding support file variables and syntax for the Symtx N1891A-2 PTS.
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Understanding Tests

Graphical
User
Interface

PSM

Table 15A brief glossary of terms

Term Definition

Measureme The process (or algorithm) that the test follows.

nt

Test The operation of running a measurement.

Calibration  Similar in most respects to a test; add, modify, and delete a calibration
using a testlD.

TestID The test identifier; a single, unique instance of a measurement,

configured for a specific need. When you “add a test” you really are
adding a new testID.

Each testID has associated support test files that specify measurement
parameters, test limits, and presentation format. When you add or
modify a testID, you edit some or all of these files.

As the system performs each test, it calls on data defined in support (parameter)
files associated with that test by the testID. Figure 6 shows the interaction
between the test-related support files and the stages of a test. Table 16 on
page 93 describes the file types and explains the interactions.

B

- *

Vee Control

all
parameters Measurement

Algorithm

Data
Presentation

—I 1 1 T )

Program
Schedule
Message
File
(.msg)

Rules File

(.rif)

Local
Parameter
File
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Files modified by the test plan developer

Noise
Source
Calibration
Data File

Data
Presentation
Header

File

(.fpf)

User-
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Calibration
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Test
Limits
File
(.tif)

Standard
Telemetry
File

(.stf)

Data
Presentation
File

(fcf)

System-

Generated
Calibration
Files

Results and
Test
Outputs

n1891a_measfil2.ai
rev51/7/04

Figure 6 Support files called during the stages of a test
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Table 16The stages of a test

Stage Description Support files used

PTS graphical * When the test operator loads atest, .msg Program schedule message (PSM)

user interface the PTS GUI obtains the program file: Defines many of the

(PTS GUI) schedule message (PSM) and rules measurement parameters (usually
file. Next, the program displays a those specific to the customer’s test
test control window where the article). Each line in the file defines the
operator can change PSM values. value for a specific parameter.

* When the operator runs the test, the rlf Rules lookup file: Determines, under
PTS GUI passes the PSM to VEE ' e '
) the PTS GUI, if the operator can make
control. (If the test conductor is .
. changes to values in the test control
running the test, the test conductor .
provides measurement parameters window. You.can lock all PSM values
and the PSM file is not used.) or only certain values. It also aII_ows
the developer to assign convenient
units to numerical values. For
example, frequency may be expressed
in MHz instead of Hz.

VEE control * VEE Control performs some steps Under VEE control, the rules file:
before the actual measurements » Converts the customer-specified
run. It reads the rules file and the units of measure in parameter files
local parameter file. VEE control to the standard units of measure
also gets the program schedule required by the system’s tests.
message from either the PTS GUI ¢ Sets the units annotation (MHZ,
or the test conductor. VEE control etc.) shown in the test control
combines the PSM and local window for each PSM parameter.
parameters, and sends them all to
the measurement.

¢ When running from a remote test Apf Local parameter file: Defines many
controller, the PSM may specify of the measurement parameters
parameters from the LPF file to (usually those unique to the
override. measurement). Each statement in the
file defines the value for a specific
parameter.

Measurement e The measurement algorithm is the  .stf Standard telemetry file:

algorithm actual process that manipulates Developer-defined file used during a
system assets to test the PTS. It telemetry request; you must set up this
reads the test limits, telemetry, and file for the measurement.
calibration data files as appropriate.

Data presentation ¢ You determine the appearance and  .fpf Data presentation header file:

(See ) Chapter 8, content of data presentations by Defines the appearance and content

“Customizing Data editing the data presentation file and of the presentation header. This is not

Presentation” data presentation header file. normally a test ID associated support

file.
fcf Data presentation file: Defines the

appearance and content of the body of
the data presentation.
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Adding, Editing, and Viewing Tests and Support Files

Adding a new test to the PTS GUI test library involves loading and modifying the
support file templates for the selected test. This section provides the procedures
for completing this process and for viewing and printing the modified support
files.

To add a test file

To add a test file

Step Notes

1 Inthe PTS GUI, click the +
to the left of the Test
Library folder to expand it
and view the test article
and phase.

2 Right-click the phase name ¢ The Add a New Test window opens.
and select New Test.

3 Type a name for the test
identifier (testID).

4 Highlight the measurement
algorithm for the test to
use.

5 Click OK. * This step loads support file templates for the
selected test.

* If the selected measurement does not require a
template file specific to that measurement, it uses
the default template for that type of support file
instead. This may generate warnings and error
messages in the System Status window (“Copy file
failed...”); ignore these messages.

* If the file name you have typed already exists in that
phase (even if it is hidden), an error message
prompts you to select another name for the test.

* The new test appears in the PTS GUI.

6 Follow the steps in the next
procedure to modify the
support files.
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To edit a test

To edit a test

Step

Notes

1 Left-click the + to the left of the test folder to
expand it and view the support files.

2 Right-click the file you want to edit and select
Open> File.

3 Edit the file using the embedded system ASCII
text editor.

4 When you have finished editing, select File >
Close, then click OK.

5 When the exit window appears, select OK to
save changes or No to discard changes.

* The file opens in an editing
window.

* The text editor uses
conventional Windows
keyboard shortcuts for cutting
(Ctrl-X), copying (Ctrl-C),
pasting (Ctrl-V), saving
(Ctrl-S), printing (Ctrl-P), and
undo (Ctrl-Z).

To view and print support files

To view and print support files

Step Action Notes
1 Viewaread-only copy ofa < Inthe PTS GUI, right-click the * A read-only copy of the file
support file. support file you want to view and appeatrs; it is grayed-out.
select Open File. * You may print the file or copy the

2 Print a support file open * From the menu bar of a support file

for viewing. open for viewing, select File >
Print.
3 Print a support file from * Inthe PTS GUI, right-click the J
the PTS GUI file tree support file you want to print and
window. select Print File.

contents to the Windows
Clipboard.

The file is sent to the Windows
default printer.

The file is sent to the Windows
default printer.

You must have a default printer set up through the Windows
Control Panel. If no printer is installed, DPService does not

function.
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7 Adding and Defining Tests and Calibrations

Defining a Test

96

To define a test (testID), you must edit the test-related support files. See “To edit
a test" on page 95. When you add a new test, the software populates the new
test with an array of files, using a template specific to each type of test. For an
overview of these files, see Table 16 on page 93.

Information about specific measurements are in the Symtx N1891A-2
Measurement Reference. An example of each type of test-related support file
can be found on the server under \N1891AEXX\etc\templates.

File syntax

File headers

Each provided file template contains a header statement that consists of the test
template file name (or path), the version number, the date and time the file was
last modified, and the name of the person who made the last modification.

The file header is not the same as the header file (“To edit a
header file" on page 110).

Variables
* Inthese files, variable syntax is variabletype ParameterName value.
» Both variabletype and ParameterName are case-sensitive.

Symtx N1891A-2 PTS User’s Guide
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Table 17Program schedule message file definitions

Purpose

Comments

File syntax (variabletype ParameterName value) Edit
?

Program schedule
message file

* Defines many test
parameters
(usually those
specific to the
individual test
article)

.msg

Settings in the PSM can have
impact on performance. For more
information, refer to the Symtx
N1891A-2 Measurement
Reference.

Syntax example: string test articlePath “P1%

variabletype Type of variable defined by each test No
algorithm: string

ParameterNa Name of the parameter; defined by No
me each test algorithm: test articlePath
value Value of the parameter; set by the test  Yes

plan developer: “P1+
Defining the PTE Configuration variable

Syntax example:
string PTEConfiguration “NSR_NDL YLC NST NIT*

e See Table 18 on page 98 for an explanation of the
parameters you must define in the PTEConfiguration
statement.
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Table 18Parameters for the PTE configuration variable

Substrin  Function If YES If NO

g?l

YSR/NSR Send results Test results are transferred automatically to the test  Test results are not transferred to the test controller.
controller server when the test is complete. There is
no Test Complete message. Results are saved and
stored locally.

YDL/NDR Display local Test results appear automatically on the monitor of ~ Test results are not automatically displayed at the end
the controlling computer at the completion of the of a test.
test.

YLC/NLC Limit checking Limit checking is turned on. Additional limit output is  Limit checking is turned off.
included in the results.

YST/NST Standard Test collects standard telemetry.2 Test does not collect standard telemetry.

telemetry
YIT/NIT Intermediate Test requests intermediate telemetry, as defined in ~ Test does not request intermediate telemetry; this

telemetry

the local parameter file (.Ipf); telemetry is taken at
each data point.

function is not available in all tests (details are in the
N1891A Measurement Reference Manual).

1 The first letter in each substring is Y for yes (the function is turned on) or N for no (the function is turned off).

2 Not all tests support standard and/or intermediate telemetry. In such cases, setting the variable to “Yes” does nothing.
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Table 19Rules lookup file definitions

Purpose Comments File syntax (variabletype ParameterName value) Edit

Rules lookup file rif Changing the frequency multiplier

e Converts the * Most tests use the global rules  Syntax example: double StartFrequency.Multiplier Edit

apIN9g S,19SN S1d 2-VI68TN XIWAS

test-conductor-passed file DefaultVeeTest.rIf in the le6 valu
units of measure (via the \etc\templates\rif folder. . : e
PSM) to the fundamental When you create a new test, the * lfthe frquency l.m'.ts are Changed. in the PSM’. change only
unit of measure required system copies this file to the 'Itztlsel\;:umerlc multiplier value (1€6) in eac_h applicable
by the tests. See new \etc\conf\ . parameter, then change the associated parameter
“Changing the frequency test_article_name\ phase\ unit to correspond.
multiplier. phase_name\ testname folder Specifying units of measure

* Sets the units annotation and renames it test_name.rlf. _ . .
(MHz, for example) « System tests require Hz as the Syntax example: string StartFrequency.Unit MHz Edit
shown in the test control fundamental unit of frequency. « To change the units appearing in the test control window, valu
window for each PSM The rules file is set up to convert edit the value of the units at the end of each €
parameter. See non-base units to base units. only

66

1t . corresponding line in the limits file
“Specifying units of
measure. Locking test control window PSM values

* Determines if the operator

Syntax example: string StartFrequency.EditAllowed “1“
can make changes to

values in the test control ¢ To lock a PSM item, add this line to the rules file: Edit

window. See “Locking test When invokina alobal lock or string ParameterName.EditAllowed “O“ valu

control window PSM g_g ¢ To unlock a PSM item, add this line to the rule file: e
unlock of PSM items, do not use ) ,

values. string ParameterName.EditAllowed “1“ only

quotation marks around the 0 or

1 value of the statement. * To lock all PSM items (global lock), add this line to the

rules file: int GlobalEditAllowed O
¢ To unlock all PSM items (global unlock), add this line to
the rules file: int GlobalEditAllowed 1
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Table 20Local parameter file definitions

Purpose

Comments

File syntax (variabletype ParameterName value)

Local parameter file Apf

* Defines many of the
measurement parameters
(usually those unique to
system measurements). Each
statement in the file defines the
value for a specific parameter.

* Settings in the LPF can affect
performance. For more information,
refer to the Symtx N1891A-2
Measurement Reference.

* Local parameter files require
fundamental units (1e9 for GHz, for
example).

* The text used for operator prompts
may not exceed 65 characters.

Syntax example: double AmpDriftError 0.01

variabletype

ParameterNa
me

value

Type of variable defined by each
test algorithm: double

Name of the parameter; defined by
each test algorithm: AmpDiriftError

Value of the parameter; set by the
test plan developer: 0.01

Yes
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Table 21To define the standard telemetry file

Purpose Comments File syntax (variabletype ParameterName value) Edit
2
Standard telemetry file .stf Telemetry under test controller Example: double RCVR temp lolimit -100
control
« The test sends a telemetry variabletype * Type of vgr?blzldefined by the Yes
request to the PTS server and statement: double
pauses, waiting for a response ParameterNa ¢ The parameter name identifies the item  Yes
from the PTS server. me for which you are setting limits:
* The PTS server forwards the RCVR_temp. This must match the
telemetry request to the test mnemonic in the statement header.
conductor control computer, with .
value * Minimum value for the parameter. Yes

Telemetry
request

Telemetry

///Telemetry
- values

items required for that telemetry
type.

* The test conductor control
computer obtains telemetry
values from the customer’s
telemetry and command system
and passes them back to the PTS
server.

Test conductor
computer

| CustomerTelemetry
andCommand

N
\Telemetry

\ values
|

request

I Measurement
computer

n1891a_telem.ai

rev212/17/03

= (rack)
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Table 21To define the standard telemetry file (continued)

Comments File syntax (variabletype ParameterName value) Edit
?

ry file Customizing a standard telemetry file

Telemetry under graphical user Syntax example: string satSignal { “SatSignal" “iteml®

interface (GUI) control vitem2” .. }
* The system sends a telemetry . ,
request to the PTS GUI. The standard telemetry file is one of the files created by the

template when you add a test. This template file contains
most of the standard elements required by that test. You
can modify, delete, or add parameters to define the phase.

* The test operator enters
telemetry values as queried by a

dialog box.
Test
operator
GfUI prciompts enters
or values Keyhoard values
GUI o Telemetry
,,,,,,, - values
P=r ]
System serve \
or rack computer 4
Telemetry — PTS
request
n1891a_Telem_lui.cdr PTS sends telemetry
rev3 12/18/03 request
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7 Adding and Defining Tests and Calibrations

Table 22To define the test limits file

Purpose Comments File syntax (variabletype ParameterName value Edit
?
Test limits Syntax example of single point parameter:
file .tif double Gain_LoLimit 50
double Gain_HiLimit 60
Values in the TLF variabletype * Type of variable defined by the statement No
define the limits to be double.
applied to test results  parameterNa * Name of the parameter: defined by each No
and affect the me test algorithm: Gain
PASS.FAIL status * The scalar value following the parameter Yes
returned from the test. | 5),e name defines a constant limit value
Test limits files require e The array following the parameter name is
fundamental units (for {LowLimit HighLimit} where LowLimit and
example, 13e6 for HighLimit are numeric values.
MHz)
Syntax example of array parameter:
double Gain lolimit {
2e9 50
3e9 55
}
double Gain Hilimit {
2e9 60
3e9 65
}
variabletype * Type of the variable defined by the No
statement: double.
ParameterNa ¢ Name of the parameter: defined by each No
me test algorithm: Gain
value ¢ The array following the parameter name Yes
defines a mask limit over a frequency
range.
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8 Customizing Data Presentation

Understanding Data Presentation Functions

106

When you run a test on the Symtx N1891A-2 PTS, it stores the resulting data in
files in CITlIfile format (see Chapter A, “Using the CITlfile Data Format” for more
information about this format). Although these results files are readable, they are
difficult to interpret. The data presentation program lets you read results files and
display the data as a graph or as a table.

The content of test results files may vary widely from one test to another. The
data presentation system accommodates these different situations using format
control files and header files. These are text files that tell the data presentation
software what data to extract from a results file and how to present it. Format
control files let you specify how data is presented; header files define the
appearance of the headings for the data.

Graph functions

Manual graph functions

For graphs, format control files let you:

» specify the datasets to plot using specific data references or trace range data
references.

» plot up to 8 datasets and 16 limit lines on a single graph.
» provide units and labels for the x and y axes.

» display header text that may provide useful information related to the data
(such as the name of the test, the time at which the test was run, and other
test-specific information).

 indicate the location of a (vertical) marker line and one or two (horizontal) limit
lines.

Automatic graph functions

For graphs, the format control file automatically:
» orients the page in landscape mode.
» sizes the graphic area to occupy as much space on the page as possible.

» scales the axes so the plot occupies most of the graphing area (although you
can also scale the graph manually).

e converts numerical data to engineering notation.

» prefixes the units in the format control file to be compatible with axis labels
(MHz or ms, for example), when the CITlfile data are in base units.

» Uses different colors and line styles when displaying multiple datasets on the
same graph, and creates a legend to interpret these colors and line styles.
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Customizing Data Presentation 8

Table functions

Manual table functions

For tables, format control files let you:

specify the datasets to use in the table.

display header text that provides useful information related to the data (such
as the name of the test, the time at which the test was run, and other
test-specific information).

indicate the size and location of tables.

specify the orientation of the page (either portrait or landscape).

specify the width of each column in the table.

provide table headings and column headings.

split columns into subcolumns, each of which has its own heading and data.
insert literal text, or scalar or array values from a results file, into a table.

Automatic table functions

For tables, the format control file automatically:

centers table titles, column headers, and column data.
reduces table dimensions to fit on the printed page.

General formats

All text in graphical and tabular output is printed in Courier font.

Although in most cases data from a single test spans several pages, you can
view only one presentation page on-screen at one time. A presentation page
may consist of more than one physical page. A table may span several
physical pages when printed, for example, but you can view the entire
presentation page on-screen by scrolling through the data presentation
window.

Any line in a header file or a format control file that starts with a pound sign (#)
is treated as a comment field. Therefore, by commenting out the appropriate
lines, you can temporarily remove a results page or header field without
having to delete and retype the entries.

Header files

The header file defines the content of header lines in a graph or table. See
“Modifying Header Files" on page 110.

You do not need a separate header file for each testID; you may point to the
same header file for any number of testIDs.
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8 Customizing Data Presentation

Header files use the .fpf extension:
file_name.fpf

Format control files

The format control file defines the content and format of the data
presentation. See “Modifying Format Control Files" on page 113.

You create a format control file for each testID.

A single format control file can contain instructions to present data both as a

graph and as a table. See Figure 7.

Each testID can have only one format control file.

Format control files use the .fcf extension:
\n1891aexx\etc\confiTestArticle_name\phase_name\test_name\file_name.fcf

Landscape Presentation Page

(Graph or Table)

Column 1... Collumn 2... Column 3...

Header

Header_files.cdr
rev 2
26julol

Figure 7 Presentation page layout examples

Table 23A Summary of Data Presentation Defaults

controlled by
file_name.fpf

Test results graph
controlled by
m file_name.fcf

Test results table
controlled by
file_name.fcf

Portrait Presentation Page
(Always a Table)

Column 1.. Column 2..

Topic

In agraph...

In a table...

Font size

Page orientation

Text is printed in 9-point Courier (the
default). You can change the font size
using a graphfontsize statement.

Pages always are printed in landscape
mode. If the header exceeds the width
of the paper, excess characters on the
right are truncated.

Text is printed in 10-point Courier. You
cannot change the font size of a table.

Pages may be printed either in portrait
or landscape mode (portrait is the
default). Use a mode statement to
change to landscape.

108
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Table 23A Summary of Data Presentation Defaults

Customizing Data Presentation

8

Topic

In a graph...

In atable...

Default page margins

Maximum objects per
presentation page

CITIfile data range

Maximum display
value 1

Minimum display
value 2

Limit lines

Maximum markers

The program automatically sizes the
graph to fit the printable page.

One per page

—1.797693e+308 to +1.797693e+308
3.40282e38

—3.40282e-38

The maximum number of limit lines is
16.

Markers are limited to one vertical, two
horizontal; both may exist in the same
graph.

The program allows two-character left
and right margins, and three-line top
and bottom margins for each printed

page.

A single presentation page can contain
unlimited tables, which may span
multiple printed pages.

—1.797693e+308 to +1.797693e+308
1.0e150

—-1.0e150

not applicable

not applicable

1 Values larger than the maximum can be read from the CITlfile, but are not displayed.

2 Values smaller than the minimum can be read from the CITlfile, but are not displayed.

Symtx N1891A-2 PTS User’s Guide

109



8 Customizing Data Presentation

Modifying Header Files

You can modify an existing header file to create either a landscape or portrait
header, depending on the type of data presentation you choose. Table 24
includes information about both types of header formats and Table 25 on

page 111 contains the keywords to use with header files. Follow these steps to

edit a header file.

To edit a header file

To edit a header file

Step

1 From Windows Notepad or any ASCII text editor, open the header file
associated with the test (\n1891aexx\etc\dp\file_name.fpf).

2 Edit the file information line at the top of the file to update the date, time, and
name of the person editing the file.

3 Add the column keyword for the first (or only) column.

4 Add the label keyword, followed by a space and the text in quotation marks, for
each line in the column

5 Add blank keywords to add blank (spacer) lines in the column.

6 Repeat step 3 through step 5 for each additional column.

Header file formats and keywords

Table 24Header file formats

Format Use File name  Description Comments
Landscape Graph or filename.fpf A landscape header has three ¢ A label is a literal string; a
header table columns. Each line contains a value can be a reference to
blank line, a label, or a data in a results file or a
label/value pair special global reference.
Portrait Table filename.fpf A portrait header has two After the system reads the
header only columns. Each line contains a header file and evaluates
blank line, a label, or a data references, it sets the
label/value pair. width of the column to contain
the data.
If the total width of the
headers exceeds the width of
the physical page, the system
truncates excess text.
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Table 25Keywords for header files

Customizing Data Presentation 8

Keywor Optio Definition Comments

d n

column Starts a new column in a header. ¢ A column statement contains no other text.

blank Inserts a blank (spacer) line into a * A blank statement contains no other text.
column.

label Example: label +title_strings @PARAMETERS.data_reference | special_reference

prec=#_of_digits mult=multiplier

data_reference

prec=#_of_digits

mult=multiplier

special_referenc
e

Inserts the specified text_string in
the current column.

Refers to a specified package and
dataset. Quickly identifies an
erroneous reference.

Specifies the number of digits to
appear after the decimal point when
displaying numerical data
references.

Multiplies all number-valued data
references by the specified value
before data references are inserted
into the title.

Refers to a quantity that is not
contained in the displayed results
file.

If title_string contains spaces or the comment
character #, you must enclose it in quotation
marks.

The inserted text may include a reference to a
scalar value in the results file, or a special
reference to a global entity.

To force a line break in a title string, use the
character sequence \n. For example:

first line in the title string\nsecond line in the
title string

The system automatically inserts a blank line
after the last line in a column heading if the
column contains data. If the column contains
subcolumns, no blank line is inserted. See
“subcolumn” on page 127.

This must be a string or a scalar value. If it is
not, or if the system cannot find the specified
package and dataset, the reference defaults to
the string <package.dataset> (the name of
the package and dataset enclosed in angle
brackets).

data_reference usually is prefaced by
@PARAMETERS.

The default value is 2.0
If #_of digits = zero, all numerical values in the
title are displayed as integers.

The multiplier can be written in fixed-point or
exponential notation. The default value is 1.0

At present, the only special reference is &date:

the current date, in the format month_name day
year hh:mm:ss, where hh is between 0 and 23.

For example: Sep 21 1994 09:53:09
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112

Sample header file

# SHeader:

column

label "Test Article:
label "Phase
label "Version
label "UL Port
label "DL Port
column

label "Test Name
label "Rack Name
label "Print Date
label "Start time
label "Stop time

/N1891AE02/etc/dp/header.fpf 3 12/07/02 1:50 Nbaliga $

@PARAMETERS . TestArticle
@PARAMETERS . Phase
@PARAMETERS .SYSTEM VERSION
@PARAMETERS . InputPortLabel
@PARAMETERS . OutputPortLabel

@PARAMETERS . TestName
@PARAMETERS . UplinkHost
&date
@PARAMETERS.StartTime
@PARAMETERS . STOPTIME
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Modifying Format Control Files

Customizing Data Presentation

Format control files define how data graphs and tables appear, and what
information is included in them. You may define a format control file for each test
and for some calibrations. Each line in a format control file has the syntax:
keyword parameter 1 .. parameter n

# optional comment

The allowable keywords are given in Table 26 on page 114 and Table 27 on
page 122, with the parameters they take. The # symbol is the comment
character. The system ignores anything that appears after the comment
character in a line. The system also ignores blank or empty lines in format
control files.

Parameters are separated by spaces or tabs in the control file. If you want a
parameter to include blanks or the comment character #, enclose the parameter
in quotes. By convention, use quotes when the parameter in question is a
header or title string.

To edit the format control file to create a graph

to edit the format control file to create a graph

8

Step

Action

Notes

1 Open the file. J

2 Define page layout. a

3 Definerequired graph a
formats.

4 Define optional graph
formats.

Using the PTS GUI, open the file \
n1891ae02\etc\confiTestArticle_name\
phase_name\test_name\testname.fcf

Use format graphical page name
to present data as a graph and to
specify a name for that presentation
page.

Use header to specify an existing
header file name.

Use title (and specify settings) to
give the graph a title.

Use xaxis to specify the units and title
of the x-axis.

Use yaxis to specify the units and title
of the y-axis.

Use trace to specify the data
reference (the source of the data
content of the graph).

Use keywords to specify option settings
such as limit lines, markers, or override
ranges.

* You can use any ASCII text editor

to modify the file.

* [tis not necessary to specify a
path, but most format control file
entries specify the fully qualified
file name, including the path.

* You may specify single or

compound data references (for up
to eight traces). See “Single data

reference” and “Compound data

reference" on page 114 for more

information.

* See Table 26, “Keywords for
graphs,” on page 114 for more

information about optional format

settings.
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to edit the format control file to create a graph (continued)

Step Action Notes

5 Close the file. * When you have finished designing the
graph, click File > Save to close the file.

Keywords for graphs

Table 26Keywords for graphs

Keyword Syntax Function Comments
data_referenc * Refers to a specified CITlfile package and a dataset e« You can specify a single data reference
e in that package. (with one trace) or a compound data
. reference (with up to eight traces limit
@package.dataset Single data reference lines) ( P ¢

* Whenever a data reference occurs in a format
control file, the data presentation program looks for a
package and dataset with the names specified in the
results file, then inserts the corresponding values
into the graph. Depending on the context, dataset
may be an independent variable, a dependent
variable, or a system parameter. In this context, it
must be an independent variable.

Example: trace @DATA.xvals

* @package and dataset are
case-sensitive.

@package.dataset Compound data reference ¢ Separate the numbers of the beginning
<beg#> <end#> * Compound data references let you concatenate up and ending datasets by at least one
to 100 datasets in a single graph. space.
Example:
trace @DATA.xvals 3 8 limit @DATA.Pin
4 11
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GTT

Table 26Keywords for graphs (continued)

Keyword Syntax Function Comments
format format graphical * Tells the data presentation program to begin anew e« The title_string in a format statement
title_string presentation page and to format the page as a does not create a title on the graph
graph. itself; you do that with a title statement.
* Creates an entry in the Available Graphs/Tables
menu in the PTS GUI.
title_string » Creates a page name for navigation; the content of < If the title_string contains spaces or the

this string appears in the System Control > Go To...
menu.

Example: format graphical “Output Power™

comment character (#), you must
enclose the string in quotation marks.

graphfontsize

graphfontsize

Selects the font size (in points) for text on the graph.

* There is no corresponding font size

(optional) [6 through 24] The default font size is 9 points. command for tables.
Example: graphfontsize 12
header header filename.fpf * Sets up the information at the top of a graph. This ¢ See “Modifying Header Files" on
keyword calls a header file you have already page 110.
defined. * The file name for the header should not
* Specifies the file header file that the data include the path.
presentation program uses to create the graph
header.
Example:
header gtheader. fpf
limit limit * Creates one limit line from a single data reference or ¢ Limit lines appear as black, broken

[data_reference_high|
data_reference_low|
data_reference range]

up to eight limit lines from a compound data
reference. See “Single data reference” and
“Compound data reference" on page 114.
Specifies the source ClTlfile/dataset for the limit
lines.

Example:

limit @DATA.PinPoutTransferLo
limit @DATA.PinPoutTransferHi
limit @DATA.Pin 1 8

lines.

¢ There is no legend reference for limit
lines.

¢ The data presentation program ignores
any limit line statements over eight.

* |f the data presentation program cannot
find a CITlfile package or dataset
specified by the data_reference, it does
not print a limit line in the graph; you do

not receive a warning or error message.
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Table 26Keywords for graphs (continued)

Keyword Syntax Function Comments

logaxis logaxis [x|y] * Selects log scale (rather than linear scale) for the x ¢ Linear scale is the default. You must

(optional) or y axis. specify log scale for each page.
Example: logaxis x

marker marker value * Sets a vertical marker at the position indicated by * Markers appear as black, broken lines.

(optional) value. * The value may be a numeric constant or

Does not determine axis scaling when autoscaling is
in effect.

See “ymarker" on page 120.

Example: marker 0

a data reference (@package.dataset).

* [f value is a data reference, it must be a
scalar (single) value.

* If you define a marker outside the data
range, the marker does not appear on
the graph.

¢ Only one vertical marker can appear on
a presentation page. If more than one
marker statement is in a page
specification, only the last statement
applies.

markerlabel markerlabel [direction

(optional) |offset | bordersize]
direction .
offset .
bordersize .

Draws a transparent box labeling the coordinates
(displayed to two decimal places) of the point where
a vertical marker intersects a trace.

Applies to the last trace statement that precedes it.

Specifies the direction, using compass points, from
the point being labeled to the label box.

Offset, in pixels, from the point to the edge of the
label box.

Bordersize is the thickness, in pixels, for the label.

Example: markerlabel SE 15 3

¢ Valid directions are N, NE, E, SE, S,
SW, W, NW. The default direction is
NW.

¢ The default offset is 20.

* Bordersize must be an integer from 0 to
20; the default bordersize is 1.
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Table 26Keywords for graphs (continued)

Keyword Syntax Function Comments
options options * Sets options that apply to the entire presentation ¢ IgnoreifEmpty is the only available
(optional) [ignoreifEmpty] page. option for this system.

* IgnoreifEmpty deletes a page from the selection list
if the page contains no valid traces.

Example: options ignoreifEmpty

 If ignoreifEmpty is not enabled, empty
pages appear in the Available
Graphs/Tables window.

pointmarkers

pointmarkers [on|off]

* Creates point marker (symbols) to differentiate

(optional) traces.

Example: pointmarkers on
range range [x|y | minval | * Manually sets the range of values displayed on the x ¢ If you omit the range statement, these
(optional) maxval | stepsize] or y axis. values are determined by the data in the

(xIy]

minval
maxval

stepsize

* Overrides the automatic range settings, which
normally show the entire data range.

* Selects the axis for which you are setting minval,
maxval, and stepsize.

e Sets the minimum value for the axis.
e Sets the maximum value for the axis.
* Sets the step interval for the display

Example:
range x le9 20e9 50e6
range y 1.5 7.5 0.5

results file.

* stepsize does not have to divide evenly
into maxval minus minval.
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Table 26Keywords for graphs (continued)

Keyword Syntax Function Comments
title title * Creates a title on the current presentation page. * You may use the title statement more
(optional) (align [left|center|right]) than once in a graph. Each title

(prec) (mult)
title_string

align

prec=#_of digits

mult=multiplier

title_string

* Align sets column alignment; select left, center, or
right.

* Specifies the number of digits to appear after the
decimal point when displaying numerical data
references.

* Multiplies all number-valued data references by the
specified value before data references are inserted
into the title.

* Defines the title for the current presentation page.

statement begins a new line in the title
of the presentation page.

If you use more than one title statement,
only the first can set alignment,
precision, and multiplier values. The
program ignores instances of these
options after the first.

The program automatically inserts a
blank line after the last title line.

The align, prec, and mult options (in any
order) must be in the first data
statement for the column. They apply to
all the data in that column.

You may have only one align, prec, or
mult option in a column.

The default alignment is center.

The default value is 2.0

If #_of digits = zero, all numerical
values in the title are displayed as
integers.

The multiplier can be written in
fixed-point or exponential notation. The
default value is: 1.0

You must specify at least one title_string
for each title statement.

If the title_string contains spaces or the
comment character (#), you must
enclose the string in quotation marks.
To force a line break in a title_string, use
the character sequence \n (example:
First Line \nSecond Line). There is no
space between \n and the start of the
text string.
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Table 26Keywords for graphs (continued)

Keyword Syntax Function Comments
trace trace data_reference ¢ Specifies the source of the traces that appear on the ¢ The dataset associated with
presentation page. data_reference must be a dependent
» Creates one trace from a single data reference or up variable.
to sixteen traces from a compound data reference. ¢ You must define at least one trace
See “Single data reference” and “Compound data statement.
reference" on page 114. * If you specify two or more traces, the
Examples: data presentation program creates a
) legend box that labels the dataset used
trace @DATA2.OutputPower for each trace.
trace @DATA.xvals 3 8 * The data presentation program ignores
any limit line statements over six.

* If the program cannot find a CITlIfile
package or dataset specified by the
data_reference, it does not print a trace
in the graph; you do not receive a
warning or error message.

¢ Data is not smoothed; data points are
connected by straight lines.

e The data presentation interprets any
value in data_reference > 3.40282e38
in absolute value as a hole value
(missing datum), and ignores it when
constructing the graph.

xaxis xaxis units * Sets parameters for the x-axis.
(optional) title_string®
units * Sets the unit value for the x-axis ¢ Units must be a base unit without any
scaling prefix.
title_string » Defines the title for the x-axis * Title_string is optional; if you omit it, the

Examples:
xaxis GHz Frequency
yaxis GHz “Frequencies Tested™

data presentation program labels the
x-axis with the name of the independent
variable from the results file.

If title_string contains spaces or the
comment character (#), you must
enclose the string in quotation marks.
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8 Customizing Data Presentation

Table 26Keywords for graphs (continued)

/ntax

Function Comments
XIS units * Sets parameters for the y-axis.
tle_string»
lits * Sets the unit value for the y-axis ¢ Units must be a base unit without any
scaling prefix.
e_string » Defines the title for the y-axis * Title_string is optional. If you omit it and

Examples:
yaxis dBm Power
yaxis dBm “Output Power™

have only one trace in the graph, the
data presentation program labels the
y-axis with name of the dataset from the
results file; if you have specified multiple
traces, the program omits the label.

* |[f title_string contains spaces or the
comment character (#), you must
enclose the string in quotation marks.

narker value

* Sets a horizontal marker at the position indicated by
value.

* Does not determine axis scaling when autoscaling is
in effect.

* See “marker" on page 116.

Example:
ymarker 0

* Markers appear as black, broken lines.

* Value may be a numeric constant or a
data reference (@package.dataset).

* If value is a data reference, it must be a
scalar (single) value.

 If you define a marker outside the data
range, the marker does not appear on
the graph.

* Only one vertical marker can appear on
a presentation page. If more than one
marker statement is in a page
specification, only the last statement
applies.

120
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To edit the format control file to create a table

To edit the format control file to create a table

Step

Action

Notes

1 Open the file.

2 Edit the file header.

3 Define page layout.

4 Define required table
formats.

5 Define optional table
formats.

Using Notepad, open the file \
n189l1aexx\etc\confiTestArticle_name\
phase_name\test_name\testname.fcf

In the file header at the top of the file,
update the date, time and name of the
person editing the file.

Use format tabular “page name”
to present data as a table and to
specify a name for that presentation
page.

Use header to specify an existing
header file name.

Use title (and specify settings) to
give the table a title.

Use mode to specify landscape or
portrait orientation.

Use column to define each column in
the table.

Use subcolumn to define each
subcolumn.

Use heading to define a heading for
each column and subcolumn.

Use data to place results data in each
column and subcolumn.

Use table to set offset and size
options.

* You can use any ASCII text editor
to modify the file.

* [tis not necessary to specify a
path, but most format control file
entries specify the fully qualified
file name, including the path.

* You may split a column into two
or more subcolumns.

* See Table 27, “Keywords for

tables,” on page 122 for more
information about optional format
settings.
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To edit the format control file to create a table (continued)

Keywords for tables

Step

Action

Notes

6 Close the file.

* When you have finished designing the

graph, choose File > Save to close the

file.

Table 27Keywords for tables

Keyword

Syntax

Function

Comments

column

column
column_nickname
width

column_nickname

width

¢ |nserts a column in the current table.

¢ Creates an identifier for the column

e Sets the width of the column in
characters.

Examples:

column left column 20
column middle column 20
column right column 20

¢ Columns are inserted in left-to-right order

* You may use any nickname that uniquely identifies that
column in that table. The nickname lets you set up
subcolumns, which are referenced to main columns.

¢ Column_nickname must contain only letters, digits, and
underscore characters.

e Column_nickname is case-sensitive.

* The column nickname is not the same as the column
heading. You must specify the column heading using
the heading keyword.
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Table 27Keywords for tables (continued)

Keyword Syntax Function Comments
data_referen » Refers to a specified CITlIfile package ¢ You can specify a single data reference or a compound
ce and a dataset in that package. data reference.

@package.dataset Single data reference e @package and dataset are case-sensitive.

* Whenever a data reference occurs in
a format control file, the data
presentation program looks for a
package and dataset with the names
specified in the results file, then
inserts the corresponding values into
the table. Depending on the context,
dataset may be an independent
variable, a dependent variable, or a
system parameter. In this context, it
must be an independent variable.

Example:

data columnl @DATA.OutputPwr
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Table 27Keywords for tables (continued)

Keyword Syntax Function Comments
data data » Specifies the source and format of the ¢ Data appears in top-to-bottom order.
column_nickname data in the specified column. * You can mix string and numerical data in a column.
(align [left|center|right] * The align, prec, and mult options (in any order) must be
)(prec) (mult) in the first data statement for the column. They apply to
data_reference all the data in that column.
column_nickname * Refers to the previously defined * You may have only one align, prec, or mult option in a
unique identifier of the column in column.
which the data is placed. See
“column” on page 122.
align * Sets column alignment; select left, * The default alignment is left.
center, or right.
prec=#_of_digits * Specifies the number of digits to * The default value is 2.0
appear after the decimal pointwhen ¢ If#_of_digits = zero, all numerical values in the title are
displaying numerical data references. displayed as integers.
mult=multiplier e Multiplies all number-valued data ¢ The multiplier can be written in fixed-point or
references by the specified value exponential notation. The default value is 1.0
before data references are inserted
into the title.
data_reference * Inserts the given data_reference in * Data_reference may be replaced by a simple string
the specified column. See statement, but prec and mult do not apply to string
“data_reference" on page 123. statements.
Example:
data columnl @DATA2.InputPwr
@DATA2 .OutputPwr
format format tabular * Tells the data presentation programto e« The title_string in a format statement does not create a

vtitle_string®

begin a new presentation page and to
format the page as a table.

Creates an entry in the Available
Graphs/Tables menu in the PTS GUI.

title on the table itself; you do that with a title statement.
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Table 27Keywords for tables (continued)

Keyword Syntax Function Comments
title_string * Creates a page name for navigation; e If the title_string contains spaces or the comment
the content of this string appears in character (#), you must enclose the string in quotation
the System Control > Go To... menu. marks.
Example:
format tabular “Output Power“
header header filename.fpf * Sets up the information at the top ofa * See “Modifying Header Files" on page 110.

table. This keyword calls a header file
you have already defined.

* Specifies the file header file that the
data presentation program uses to
create the table header.

Example:
header gtheader. fpf

¢ The file name for the header should not include the
path.

¢ A table header is not the same as a table column
heading.
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Table 27Keywords for tables (continued)

Keyword

Syntax

Function

Comments

heading

data
column_nickname|
subcolumn_nickname
(align [left|center|right]

)(prec) (mult)
» title_string”

column_nickname
subcolumn_nickname

align [left|center|right]

prec=#_of_digits

mult=multiplier

title_string

Defines the heading for a column or
subcolumn.

Refers to the previously defined
unique identifier of the column or
subcolumn in which the data is
placed. See “column” on page 122
and“subcolumn" on page 127.

align sets column alignment; select
left, center, or right.

Specifies the number of digits to
appear after the decimal point when
displaying numerical data references.

Multiplies all number-valued data
references by the specified value
before data references are inserted
into the title.

Defines the title for the column or
subcolumn.

Examples:

heading
heading
heading
heading
heading

You may have only one heading in each column or
subcolumn.

You must specify the nickname of the column or
subcolumn in which the heading appears.

The align, prec, and mult options (in any order) must be
in the first data statement for the column. They apply to
all the data in that column.

You may have only one align, prec, or mult option in a
column.

The default alignment is center.

The default value is 2.0
If #_of digits = zero, all numerical values in the title are
displayed as integers.

The multiplier can be written in fixed-point or
exponential notation. The default value is 1.0

You must specify at least one title_string statement for
each column or subcolumn.

If the title_string contains spaces or the comment
character (#), you must enclose the string in quotation
marks.

To force a line break in a title_string, use the character
sequence \n (example: First Line \nSecond Line).
There is no space between \n and the start of the text
string.

left column align=center mult=1e9 prec=3 “Power Out at"

middle column align=center mult=1e9 pre=3 “Frequency (GHz)"
subcolumnl align=center mult=1e9 prec=3 First

subcolumn2 align=center mult=1e9 prec=3 Second

right column align=left mult=1e9 prec=3 “Relative \nPower (dB)*"
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Table 27Keywords for tables (continued)

Keyword Syntax Function Comments
mode mode [landscape| * Sets the orientation of the printed The default is portrait.
(optional) portrait] table. The mode statement may appear anywhere in the page
. specification.
Example:
mode landscape
subcolumn subcolumn * Inserts a subcolumn in the current Subcolumns are referenced to main columns.
subcolumn_nickname column. Place subcolumn statements immediately following the
width column in which they appear.
subcolumn_nickname ¢ Creates an identifier for the Insert subcolumns n left-to-right Or‘?‘ef o
subcolumn You may use any nickname that uniquely identifies that
subcolumn in that table.
width * Sets the width of the subcolumn in subcolumn_nickname must contain only letters, digits,
characters. and underscore characters.
column_nickname is case-sensitive.
The subcolumn nickname is not the same as the
Examples: subcolumn heading. You must specify the subcolumn

subcolumn subcolumnl
left column 10 column
subcolumnl left column 10

heading using the heading keyword.
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8 Customizing Data Presentation

Table 27Keywords for tables (continued)

ntax

Function

Comments

)le row_offset

lumn_offset width

ight

v_offset

lumn_offset

jth

ight

Sets the dimensions and location of
the table

Sets the number of blank lines
between the bottom of the header and
the first row of the table.

Sets the number of blank characters
between the leftmost printing position
on the page and the first column of
the table.

Sets the overall width of the table in
characters

Sets the number of lines the table
occupies on each printed page.

Example:
table 1 3 40 20

* The data presentation program automatically reduces

the size of the table to fit within the printable margins of
the page. Offsets do not change, which lets you change
page orientation without having to change the settings.
The program adds pages to accommodate overflow
columns and rows.

Horizontal measurement is 10 character per inch.

Vertical measurement is 6 lines per inch

The example creates a table with a row_offset of 1
character,

a column_offset of 3 characters, a width of 40
characters and

a height of 20 lines.

128
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Table 27Keywords for tables (continued)

Customizing Data Presentation

8

ntax

Function Comments

e * Creates a title on the current * You may use the title statement more than once in a

ign [left|center|right] presentation page. table. Each title statement begins a new line in the title

orec) (mult) of the presentation page.

e_string * If you use more than one title statement, only the first
can set alignment, precision, and multiplier values. The
program ignores instances of these options after the
first.

* The program automatically inserts a blank line after the
last title line.

* The align, prec, and mult options (in any order) must be
in the first data statement for the column. They apply to
all the data in that column.

* You may have only one align, prec, or mult option in a
column.

gn * Align sets column alignment; select The default alignment is center.
left, center, or right.

2c=#_of_digits * Specifies the number of digits to ¢ The default value is 2.0
appear after the decimal pointwhen  « If# of digits = zero, all numerical values in the title are
displaying numerical data references. displayed as integers.

lit=multiplier * Multiplies all number-valued data * The multiplier can be written in fixed-point or
references by the specified value exponential notation. The default value is 1.0
before data references are inserted
into the title.

2 string * Defines the title for the current * You must specify at least one title_string for each title

presentation page.

Example:

title align=center mult=1e9 prec=

statement.

If the title_string contains spaces or the comment
character (#), you must enclose the string in quotation
marks.

To force a line break in a title_string, use the character
sequence \n (example: First Line \nSecond Line).
There is no space between \n and the start of the text
string.

3 “Power versus Frequency™

Error conditions in tables

When the data to be displayed is too wide, too large, too small, or missing, the
data presentation program uses special symbols to report these special

conditions.
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8 Customizing Data Presentation

Table 28Error symbols

Definition

Missing data (data reference does not exist)

Overflow (data too large to fit in cell)

Data value greater than 1.0 x 1

0150

Data value less than —1.0 x 1010

A simple presentation file control file (.fcf)

Table 29 creates a graph and a table from CITlfile data. The data package,
named DATA, contains two datasets: xvals (independent data) and yvals

(dependent data).

Table 29Format control file with functional explanation

Command

Function

format graphical “Intensity Graph"

xaxis sec Time
yaxis W “Flash Intensity™

trace @DATA.yvals

format tabular “Intensity Table®

table 2 15 30 20

title “Raw Test Data“

column time 15
column intensity 15

heading time “Elapsed\nTime\n(s)*

Data is formatted as a graph titled Intensity Graph.

The x-axis measures seconds and is labeled Time.
The y-axis measures wattage and is labeled Flash
Intensity. The label for the y-axis is in quotation marks
because it contains a space.

The trace statement defines the data source as the
ClITlIfile package DATA and dataset as yvals. The trace
statement loads the values of the independent variable
xvals.

The same data is also formatted as a table title Intensity
Table.

The table has two blank lines before the first row,
indents 15 characters from the left printable edge of the
page, is 30 characters wide, and is 20 lines long.

The table title is Raw Test Data

The table has two columns, each 15 characters wide,
with the nicknames time and intensity (these are not the
column headings).

The heading for the column nicknamed time is centered
(the default) and has a three-line heading:

Elapsed

Time

(s)

130
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Customizing Data Presentation 8

Table 29Format control file with functional explanation

Command Function
heading intensity “\nIntensity\ * The heading for the column nicknamed intensity is
n(uw) centered (the default) and has a three-line heading that

starts with a blank line:

<blank line>

Intensity

(uw)
data time @DATA.xvals * Content for the column nicknamed time comes from the

CITIfile package DATA and from the dataset xvals.
data intensity mult=1.0E6 * Content for the column nicknamed intensity comes from
@DATA.yvals the CITlfile package DATA and from the dataset yvals.

This data is multiplied by 108 before insertion in the
table. For a table, the scaling factor must be stated
(graphs scale automatically).
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8 Customizing Data Presentation

Printing Tables and Graphs

A presentation page may span several printed pages. See
“General formats" on page 107.

Printer selection

DPService (the data presentation program) uses the Windows NT operating
system to select the destination printer and to control printer options. You can
change printer settings and monitor the print queue using the Windows NT Print
Manager.

Printing options
From the section menu of the local user interface, you have three options for
printing files:
» Click the printer icon to print the current presentation page.

» Select Section > Print Current Section to print the current presentation
page.
» Select Section > Print All to print all pages in the presentation.

You must have a default printer set up through the Windows
NT Control Panel. If no printer is installed, DPService does
not function.
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9 Monitoring Drift of System Cables

Introducing Drift Monitoring Using the Thermal Vacuum
Calibration

The Symtx N1891A-2 PTS contains specific hardware and software to measure
the drift of the system cables over time and temperature. The system was
designed with the ability to make these measurements without disconnecting the
test set-up. This capability is ideal for understanding the effects on system
cabling while in the thermal vacuum environment. With the use of internal and
external loopback cabling, the user has the ability to execute the thermal
vacuum calibration to determine how much the system cables have drifted from
the specified reference run. For more detail on the Thermal Vacuum Calibration,
see the Symtx N1891A-2 Measurement Reference guide.

The Symtx N1891A-2 PTS hardware is designed with three loopback points: one
is external and the other two are internal. The internal loopback points are
located in the Remote Unit (144140) and the TVAC unit (144141). For detailed
information, see the LMN5002 MOUS RF ICD Drawing (144104). The external
loopback is created by connecting two equal length cables together and
attaching the other ends of the cables to the Cal In and Cal Out ports on the
TVAC unit. The user has the flexibility to also select any pair of designated uplink
and downlink ports to connect the external loopback cables.

The user must use two equal length cables to connect between the specific ports
being used for the external loopback path.

The system loopbacks allow the user to monitor for cable drift error at three
different planes in the system. The Remote Unit loopback enables monitoring of
the cables connected between the PTE unit and the Remote Unit. The TVAC
Unit loopback enables monitoring of the cables connected between the PTE Unit
and the Remote Unit in addition to the cabling between the Remote Unit and the
TVAC Unit. The external cable loopback enables the monitoring of the sum of all
cables connected between the PTE Unit and the UUT. The user has the ability to
select Thermal Vacuum Calibration and perform the measurement on one or all
three of these loopback paths.

The PTE Unit, Remote Unit, and TVAC Unit were designed with equal length
cabling between designated switches used especially for calculating the
contributions of the uplink and downlink respectively.
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Monitoring Drift of System Cables 9

Measuring Drift of System Cables

The most probable cables to drift in the system are those cables located in the

thermal vacuum chamber between the TVAC unit and the UUT. Therefore, the

operator should consider using the external loopback cable as the primary path
for measuring the system drift and storing the required calibration offsets to be

used by the measurements during all future executions. In the case where the

external loopback can not be used, the TVAC unit loopback path should be the
alternate.

In order to monitor drift and define calibration offsets, the user must first perform
the thermal vacuum calibration to determine the reference measurements on the
loopback paths. The results from the reference run are used to compare against
the real time results each time the calibration is executed. It is recommended
that when the reference run is performed, all three loopback paths are
measured. To perform the thermal vacuum calibration, the user should select the
calibration from the test library and load the test. Once loaded, the operator is
required to enter the appropriate information required for execution. Definition of
these parameters and values are described in the Symtx N1891A-2 Measurement
Reference guide. The operator should verify that the parameter values are set to
perform the reference run on each of the loopback paths.

If the system and/or its cables' temperature changes by 5 degrees from the
reference run, a period of 14 days has elapsed, or the measurement results
suggest something has changed, the thermal vacuum calibration should be
performed. During this execution, the parameters should be set to perform the
offset measurement on the external loopback cable. The user may choose to
skip the internal loopback paths. During the execution of the calibration, the
measured results are compared to the reference results in order to calculate an
offset. The offset is then displayed to the user and the user may choose to save
the offset or cancel the offset. If the offset is less than 0.1 dB, it is recommended
that the offset not be saved.

Once an offset is saved, all measurement results from this point on will be
corrected per the offset value. See the Symtx N1891A-2 Measurement Reference
guide for how corrections are applied.
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9 Monitoring Drift of System Cables

Troubleshooting System Drift

136

The user has the ability to troubleshoot and determine which part of the system
is contributing to the drift error measured. The user has the ability to specify the
execution of the thermal vacuum calibration in the "test” mode for one or all
three of the loopback paths. In the "test” mode, the calibration routine will
measure and determine the offset number for the paths chosen, but will not store
any correction factors.

Any drift error measured on the execution of the calibration through the external
loopback path will be the sum of the drift error from the Vector Signal Analyzer
(VSA) to the UUT. Therefore, the drift error contributions can be all or in part
from the cables between the PTE Unit and the Remote Unit, Remote Unit and
TVAC Unit, and the TVAC Unit and UUT. By executing the thermal vacuum
calibration in the "test" mode on the other loopback paths, the user can
determine which paths are contributing to the total drift error.

The drift contributions are defined as follows:

» Adrift error measured in the Remote Unit loopback path can be contributed to
the cable between the PTE Unit and the Remote Unit.

» A drift error measured in the TVAC Unit loopback path can be contributed to
the cable between the Remote Unit and the TVAC Unit.
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A Using the CITIfile Data Format

The CITIfile Format

138

CITlIfile—which stands for common instrumentation transfer and interchange
file—is a standardized data format, used for exchanging data between
computers and instruments. CITIfile defines the format of the data inside an
ASCII package. Because it is not tied to any particular disk or transfer format,
you can use CITlfile with any operating system (BASIC, MS-DOS, UNIX), with
any disk format (LIF, DOS, HFS), or with any transfer mechanism (disk, LAN,
GPIB). By careful implementation of the standard, instruments and software
packages using ClITlIfile can load and work with data created on another
instrument or computer.

CITlfile is independent of the data storage mechanism and may be implemented
for any file system. However, transfer between file systems sometimes may be
necessary. You may use commercially available software that can transfer ASCII
files between systems, to transfer CITlfile data.
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CITIfile Terms

The following terms are used when working with CITlfile. Refer to these
definitions as necessary.

CITIfile package

A typical CITlIfile package has two parts: a header, made up of keywords and
setup information; and data, usually consisting of one or more arrays of data. A
file may contain more than one ClITlfile package.

CITIfile header

The header contains information about the data that follows. It may also include
information about the setup of the instrument that measured the data.

CITIfile data array

An array is numeric data arranged with one data element per line. A CITlfile
package may contain more than one array of data.

Data arrays start after a BEGIN keyword and close with an END keyword
following the last data element in an array. A CITlfile package does not
necessarily need to include data arrays; for instance, CITlfile could be used to
store the current state of an instrument. In that case the keywords VAR, DATA,
BEGIN, and END would not be required.

CITIfile keywords

A keyword is always the first word on a new line and is always one continuous

word without embedded spaces. Table 30 on page 140 contains all the keywords
used in the latest version of CITlfile.

When a program reads a ClITlfile, it ignores unrecognized keywords. This
approach lets you add new keywords without affecting an older program or
instrument that might not use the new keywords.
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Table 30CITlIfile keyword reference

Term

Sample

Description

CITIfile

Name

Var

CITIFILE

NAME CAL_ SET

VAR FREQ MAG 201

#NA POWER1
1.0E1

Identifies the file as a CITlfile and indicates the revision level of the
file. The CITIFILE keyword and revision code must precede any
other keywords. The CITIFILE keyword at the beginning of the
package assures the device reading the file that the data that follows
is in the CITlfile format. The revision number allows for future
extensions of the CITlfile standard.

Allows the current CITlfile package to have a unique identifier. The
name of the package must be a single word with no embedded
spaces.

Standard Package Definition
Names

RAW_DATA Uncorrected data

DATA Data that has been error-corrected. A
single data array should be named DATA

FORMATTED Corrected and formatted data

MEMORY Data trace stored for comparison
purposes

CAL_SET Coefficients used for error correction
CAL_KIT Description of the standards used
DELAY_TABLE Delay coefficients for calibration

PARAMETERS Describes actual test settings used in a
measurement

RESULTS Contains the pass/fail results of a
measurement

Defines the name of the independent variable (FREQ), the format of
values in a VAR_LIST_BEGIN table (MAG), and the number of data
points (201). Typical names for the independent variable are FREQ
(in Hz), TIME (in seconds), and POWER (in dBm). For the
VAR_LIST_BEGIN table, only the MAG format is supported.

Allows definition of variables specific to a particular type of device.
The pound sign (#) tells the device reading the file that the variable is
for a particular device. NA indicates that the information is for a
network analyzer. This convention allows new devices to be defined
without fear of conflict with keywords for previously defined devices.
The device identifier may be any length.

140
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Table 30CITlIfile keyword reference (continued)

Term Sample Description

Seg_List Begi SEG_LIST BEGIN Indicates that a list of segments for the independent variable follow.
n Format for the segments is
<segment type> <start> <stop> <number of pointss>.

The current implementation supports only a single segment. If there
is more than one segment, the VAR_LIST_BEGIN construct is used.
CITlIfile revision A.01.00 supports only the SEG (linear segment)
segment type.

Seg List End SEG_LIST END Defines the end of a list of independent variable segments.

Var_List Begi VAR _LIST BEGIN Indicates that a list of the values for the independent variable
n (declared in the VAR statement) follow. Only the MAG format is
supported in revision A.01.00.

Var_List End VAR _LIST END Defines the end of a list of values for the independent variable

Data DATA S[1,1] RI Defines the name of an array of data that is read later in the current
CITlIfile package, and the format that the data is in. Multiple arrays of
data are supported by using standard array indexing as shown
above. Versions A.01.00 and A.01.01 of CITlIfile support only the RI
(real and imaginary) format, and a maximum of two array indexes.
Commonly used array names include:

e S for S-parameter Example: s[2, 1]

e E for error term Example: E[1]

* USER for user Example: USER[1]
parameter Example: VOLTAGE [1]

* VOLTAGE for specific ~ Example: VOLTAGE_RATIO[1,0]
voltage

* VOLTAGE_RATIO fora
ratio of two voltages

(A/R).
Constant CONSTANT <name> Lets you record values that do not change when the independent
<value> variable changes. CONSTANTSs are part of the main CITlfile

definition. Users must not define their own CONSTANTSs. Use the
#KEYWORD device specification to create your own keyword
instead. No constants were defined for revision A.01.00 of CITlfile.
ClITlfile revision A.01.01 defined the following constant:

CONSTANT TIME <year> <month> <day> <hour> <minute>
<seconds>
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CITIfile Conventions

Note the following conventions when working with the CITlfile format.

Line length

The length of a line within a CITIfile package must not exceed 80 characters.
This limitation allows instruments that have limited RAM to define a reasonable
input buffer length.

Keywords
Keywords always start a new line. The end of a line is defined by the file system
or transfer mechanism being used.

Separators

The blank (ASCII character 32 decimal) separates keywords and numeric fields.

Unrecognized keywords

When devices read a CITlIfile, they ignore unrecognized keywords.

Adding new devices

Users can create device keywords by prefacing the keyword with the
user-definition character, the pound sign (#). See the listing for # in Table 30 on
page 140 for more information.

File names

Some instruments or programs identify a particular type of file by characters that
are added before or after the file name. Creating a file with a particular prefix or
ending is allowed, but an instrument or program must not require these
characters to read a file. This allows any file, no matter what the file name, to be
read by the instrument or computer.
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